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Preface 

edocs Customer Self-Service 
edocs is the world’s leading provider of customer self-service and e-billing software and 
services. Its solutions help service providers increase customer loyalty while reducing the 
overall cost to serve their customers. Service providers use the software to move 
customer service interactions from expensive paper and call center-based channels to 
lower-cost and more responsive self-service and assisted care channels like the web, e-
mail and IVR. 

edocs software has been deployed in some of the most challenging business and technical 
environments in the world and has proven to be the industry’s most scalable and reliable 
solution. The applications have been continuously developed and refined to deliver the 
most comprehensive functionality available. As a result, edocs customers consistently 
gain the highest adoption and ROI in the communications industry – typically 5-10 times 
higher than companies using in-house or competing packaged solutions. 

Self-Service for Consumers and Businesses 

Many billing and customer care processes today are expensive, inefficient and 
unsatisfactory for both communication service providers (CSPs) and their customers. 
With edocs’ customer self--service and e-billing solutions, carriers empower their 
business and consumer customers to serve themselves and address all of their account 
and service-related activities online, instead of going through a call center, account rep, 
or retail outlet. For end customers, this makes doing business with a service provider 
more convenient, more efficient, and more satisfying. For service providers, it means 
improved competitive differentiation, significantly reduced customer care costs, 
increased customer loyalty and streamlined billing/payment processing. 

Contact centers provide the key to unlocking the potential business benefits of customer 
self-service. Contact center statistics show that 60-80 percent of customer service issues 
relate to a customer’s account. For this reason, edocs customer self-service solutions 
provide direct access to detailed account information, and interface with complementary 
front-and back-office systems to provide access to a variety of account-related services. 
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edocs e-Billing Manager 
edocs e-Billing Manager enables organizations to deliver interactive access to electronic 
bills for both consumers and businesses with online payment. With edocs e-billing 
platform, organizations can cost-efficiently present various bills online and provide users 
with multiple online payment options. 

Designed to integrate with existing online applications and diverse core legacy systems, 
edocs e-Billing Manager extends the convenience of online self-service to an 
organization’s entire customer base, as well as to its call centers. Online account e-bills 
with payment enables key features such as drill-down to more detail, “paper turn-off ” 
and access to advanced self-service capabilities, offering an online experience that 
provides superior service and value to customers, while decreasing the cost of servicing 
those customers. 

• Multi-Bill Quick Navigation 

• Account Aggregation 

• Online Payment Wallet and Payment History 

• Archiving via a “Virtual file cabinet with years worth of statements” 

• Customer and Company Profile Management 

• Notifications and Alerts 

• Paper Turn-Off Support 

• Targeted Marketing Promotions 

• Print and Download Functionality 

edocs platform powers self-service solutions for leading organizations worldwide. The 
unmatched scalability and performance (1) of edocs platform enables organizations to 
serve millions of end-customers with real-time access to years of statement data. 

 

e-Billing Benefits 

Improve Service Levels 

• Allow customers to opt in for secure online e-bill delivery, providing valuable and 
convenient 24x7 access to e-bills for customers and service representatives. 

Accelerate Cash Receipt 

• Online payment accelerates cash receipt and reduces float from Days Sales 
Outstanding (DSO) 

Generate Revenue 

• Promote targeted offers within e-bills to increase product or service cross-sell. 

Reduce Service, Print and Mail Costs 
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• Handle customer requests for billing reprints and account information online, 
replacing costly phone calls. 

• e-Billing reduces paper bill production and mailing costs by saving $924,000 
annually per 100,000 customers enrolled. 

• Online customers make 30% fewer calls to call centers. 

edocs solution has demonstrated an over 20% paperless enrollment rate among its 
deployments. 

Key Features of e-Billing Manager 

edocs e-Billing Manager is designed to serve the diverse needs of the entire 
organization’s business segments and constituents. Key features of edocs e-Billing 
Manager include: 

Interactive Statement Presentment - e-Bills can be presented in both a dynamic 
fashion, using HTML, and in a print-friendly format using PDF. When presented in 
HTML, e-bills provide an interactive Web experience with search, sorting, filtering, drill-
down and download capabilities. Furthermore, dynamic HTML presentment allows 
embedded links so customers can click-through and drill-down to more detailed 
information and self-service functions. 

Combined Accounts Statement - edocs e-Billing Manager creates a single consolidated 
view of all of a customer’s accounts by aggregating account information from multiple 
disparate legacy systems. Using the application’s self-service features, accounts can be 
linked by customers themselves, or automatically, by the biller in the background. 

Online Payments - e-Billing provides personal wallets for managing multiple payment 
vehicles (for example credit cards or checking accounts). Users or permitted customer 
service representatives (CSRs) may make one-time payments, establish scheduled 
recurring payments, view payment history, set thresholds and payment alerts. 

Paperless Account Option (Print-Friendly Statements) - Customers have the ability to 
turn off paper via a managed consent model with both print-friendly PDF or HTML 
presentment alternatives online. edocs solution complies with regulatory requirements for 
paperless delivery and has demonstrated an over 20%paperless enrollment rate among its 
deployments. 

Multi-Year Statement History and Online Archive - A disk-efficient, high 
performance statement archiving system gives organizations the flexibility to store years 
of historical account statements and account-related communications without degrading 
performance or increasing storage costs. 

Notifications and Alerts - E-mails and messaging alerts notify customers about account 
changes, payment events and updates. “Statement ready” notifications draw customers to 
the security of the online site and encourage ongoing use. In addition, customers can 
configure and manage personalized alerts such as when a checking balance is below 
certain level, a change was made to the account profile or that a Secure Message response 
to an inquiry is available for review. Customers can also designate their preferred 
notification channels including e-mail, PDA and mobile phone. 
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Contextual Self-Service and Customer Care - While customer self-service is often 
available via an organization’s website, integrating it into e-bills and making it contextual 
makes it easier for customers to find relevant information and act immediately. It also 
creates an opportunity for the organization to promote self-service operations that may 
otherwise be unknown or difficult to find on a site. Examples of self-service include 
changing an address, turning off paper, or initiating a dispute or an account inquiry. 

Downloads - edocs e-Billing Manager supports a variety of download formats that allow 
customers to conveniently manage their account information off line using personal 
financial management (e.g. Quicken, MS Money) or Microsoft Office (e.g. Excel, 
Access) applications. To meet most customers’ needs, edocs supports OFX, QIF, CSV, 
XML, EDI and PDF download options. 

Branch, Agency and Kiosk Access - Branch employees are granted access privileges to 
view and reprint customer’s e-bills through a standard web browser, expediting customer 
service requests. In addition, branch self-service kiosks can facilitate customer in-branch 
service needs. 

CSR Call Center Access - edocs e-Billing Manager provides customer service 
representatives (CSRs) with customer impersonation rights to access customer e-bills 
from a standard web browser. CSRs can easily facilitate both online and off line customer 
service requests since they can view the same statements that customers are inquiring 
about. edocs customer service dashboard can incorporate additional operational data such 
as service/payment history and personalized marketing offers into CSRs’ views to give 
them a more comprehensive view of the organization’s relationships with customers. 

Targeted Promotions and Messaging - Customized product offers or personalized 
service messages can be presented to customers within e-bills based on individual 
customer-specific account information. This creates additional revenue generation 
opportunities and improves marketing efficiency by reducing direct mail and 
telemarketing costs. Furthermore, since offers are so highly targeted, customers are more 
likely to respond to them. 

e-Billing Manager Features Overview 

e-Billing Manager is the leading electronic bill presentment and payment (EBPP) 
solution for communications service providers. e-Billing Manager provides the mission-
critical application platform required for securely managing customer account 
information such as bills, statements, and other data. With e-Billing Manager, carriers can 
provide business and consumer customers with highly personalized online account 
information and self-service capabilities that can be served across multiple channels 
(Web, PDF, hand-held devices and e-mail). It serves as the foundation for managing 
recurring customer relationships. 

e-Billing Manager is specifically designed for organizations with large numbers of 
customers, high data volumes and extensive integration with systems and business 
processes across the enterprise. With its sophisticated data access layer, platform services 
and data stores, e-Billing Manager is uniquely capable of powering the most complex 
EBPP and Customer Self-Service solutions. 
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Realizing that consumer and business customers have very different service needs, e-
Billing Manager is available in a consumer edition and business edition with specific 
features and functionality designed for each user base. 

The core capabilities of the e-Billing Manager application editions are detailed below. 

e-Billing Manager Consumer Edition 

e-Billing Manager Consumer Edition dashboard 

 

e-Billing Manager Consumer Edition is focused on the self-service needs of a large 
consumer base. The core features of the application are described below. 
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Customer Account Dashboard 

Bills or statement data is dynamically presented within the application dashboard. Once 
properly authenticated, users can easily and conveniently navigate and view their billing 
statements, account summaries and bill details. 

Electronic Bill Presentment and Consolidation 

Consumer customers can access their bills or invoices online, including historical bills 
stored for as many years as the service provider prefers. Each monthly bill, for a single 
service or consolidated for multiple services, is presented in dynamic fashion using 
HTML and can include up-to-date account information such as current balance, bill 
details, unbilled-usage, last payment received, last payment date, etc. Customers can sort 
table columns, filter and drill-down into the call detail to further validate charges. 

Electronic Bill Payment and Posting 

Customers have the complete flexibility to control how and when payments are made. 
Payment is set up via bank and/or other credit accounts within e-Billing Manager to 
execute instant payments or to schedule future automatic payments. Customers have the 
ability to view the status and record of previously made payments. e-Billing Manager 
also provides an accounts-receivable settlement file for the service provider with the 
following information: payment amount, payment date, statement number, account 
number, payment account, payment type (one-time/recurring) and return status (yes or no 
with corresponding negative amount). Users can change their payment options and user 
preferences within the application. They can also establish multiple payment methods and 
payment notification preferences, make one-time payments, automate recurring 
payments, and set payment thresholds and reminders. 

User Profile Management and Notifications 

User information and settings are presented and modified within the application. Users 
may update their profile information, correct personal data, and manage password or 
notification options, email addresses, and other personal preferences. 

Customer profiles may be updated on a real-time basis at anytime while the customer is 
properly authenticated. Profile information such as the customer’s preference for account 
notifications can be set. e-Billing Manager manages and sends e-mail messages 
concerning individual accounts or transaction events. A variety of conditions or 
circumstances can trigger email notifications. Service providers may wish to enable some 
common notifications:  

• Current statement available 

• Payment reminders 

• Payment confirmations 

• Payment rejections 

• Payment overdue 

• Threshold exceeded on recurring payments 
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• Credit card expiration pending 

Users may establish multiple notification or alert options and modify their settings at any 
time. 

Unbilled Data Presentment 

Unbilled account charges can be viewed online prior to bill cycle closing within the 
application. Users can view their charges as well as analyze to-date spending for the 
current billing period.  

B2C Reporting 

Specific reports come with the application whereby users may view summaries, analyze 
charts, and access their complete statement history using built-in reporting features. 
Furthermore, users may also drill-down through account information, bill or statement 
data within the application. Specifically, they can page through bill details, sort across 
pages, sub-total and filter account information viewing dynamic reports. 

Print Friendly Views, PDFs and Downloads 

Users may access print friendly views, request a dynamic PDF of their statement, or 
select to download a dataset. These features are all available for key application views. e-
Billing Manager’s versioned, disk-efficient and high performance bill archiving feature 
along with its print-friendly views makes generating hard-copy reprints simple and 
efficient. 

Customer Service Representative (CSR) Views 

e-Billing Manager also provides a lightweight solution for customer service management. 
CSRs can also “impersonate” the user to facilitating the efficient servicing of online 
accounts. For example, representatives may have roles that provide application access to 
execute payments, reset passwords or simply search accounts to view the customer 
statement. The application may also be extended for complete case management with 
edocs CSR Manager Application, providing additional case creation, routing and 
tracking, status views of cases, escalation workflows and queuing. Cases can either be 
completely automated without agent intervention based on predetermined business rules, 
or routed appropriately to engage an agent for resolution.  
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e-Billing Manager Business Edition 

e-Billing Manager Business Edition Dashboard 

 

 

e-Billing Manager Business Edition is focused on the self-service needs of an enterprise 
customer base. The core features of the application are described below. 

Corporate Account Dashboard 

Account information, bills or statement data is dynamically presented within the 
application by the business billing structure. Once properly authenticated, managers, 
administrators and users may view consolidated account summaries, sub-accounts, 
individual statements or all bill details based on their access permissions for the billing 
structure. 
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Hierarchical Billing and Business Structures 

Billing structures are presented within the application as account hierarchies. Managers 
or administrators may search, view and update their billing structure by assigning other 
attributes to hierarchy nodes, such as meaningful names. Users are assigned within the 
billing structure, defining navigation within the account and sub-accounts of billing data. 
Administrator assignment in the billing structure may provide access to the entire 
enterprise or limit a single user to viewing their individual statement only. By creating 
separate business structures within the application, users may maintain multiple 
hierarchies of their own. Billing structures and user created business structures offer 
different views of account information for segmentation, payment, analysis and reporting. 

Electronic Bill Presentment and Consolidation 

Business customers can access their bills or invoices online including historical bills 
stored for as many years as the service provider prefers. Each billing period, for a single 
service or consolidated for multiple services, is presented in dynamic fashion using 
HTML and can include up-to-date account information such as current balance, bill 
details, last payment received, last payment date, etc. Furthermore, accounts can be 
consolidated across disparate system using either full data consolidation via an external 
data store or summary consolation by dynamically linking the accounts. Customers can 
sort table columns, filter and drill-down into the call detail to further validate charges. 

Cross Invoice/Sub-Invoice Payment 

Payment options and enterprise preferences can be presented and modified within e-
Billing Manager. Administrators may establish multiple payment methods and payment 
notification preferences, make one-time payments, schedule automated recurring 
payments, and set payment thresholds and reminders. Administrators may also make a 
single payment across multiple invoices, defining the payment allocation, even allocating 
payment to sub-invoice charges. Administrators have the complete flexibility to control 
how and when payments are made. Payment is set-up via bank and/or other credit 
accounts within e-Billing Manager to execute instant payments or to schedule future 
automatic payments. Administrators also have the ability to view the status and record of 
previously made payments. e-Billing Manager integration provides an accounts 
receivable settlement file to the service provider with the following information: payment 
amount, payment date, statement number, account number, payment account, payment 
type (one-time/recurring) and return status (yes or no with corresponding negative 
amount). 

User Roles and Permissions 

User roles and permissions can also be presented and modified within the application. 
Administrators may update user role or access, establishing view only permissions, 
accounts receivable roles, managerial access, etc. This feature may be configured based 
on the provider business requirements or back-off ice integration needs. 
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Corporate and User Profile Management and Notifications 

Corporate profiles are managed by designated administrators, whereas users may update 
their own profile information, correct personal data, and manage password or notification 
options, email addresses, and other personal preferences. 

Corporate and user profiles may be updated on a real-time basis at anytime while 
properly authenticated. Profile information such as the corporate contact preferences for 
account notifications can be set. e-Billing Manager manages and sends e-mail messages 
concerning accounts or transaction events. Notifications may be aggregated for account 
and sub-accounts events and limited to administrator or managerial roles. A variety of 
conditions or circumstances can trigger email notifications, so service providers may 
wish to enable some common notifications: 

• Current corporate statements are available 

• Payment reminders 

• Payment confirmations 

• Payment rejections 

• Payment overdue 

• Threshold exceeded on recurring payments 

• Credit card expiration pending 

Corporate administrators and users may establish multiple notification or alert options 
and modify their settings at any time. 

Unbilled Data Presentment 

With e-Billing Manager, managers, administrators and users may view unbilled account 
charges prior to bill cycle closing. All users may view their charges and analyze to-date 
spending for the current billing period. This feature may be configured based on the 
provider business requirements or back-office integration needs. 

Advanced Reporting 

Specific reports come with the application whereby users may view summaries, analyze 
charts, and access their complete statement history using built-in reporting features. 
Additional business reports are also provided whereby administrators may view a set 
library of summarized cost reports and charts. These “roll-up” reports provide for broad 
analysis of account activity for corporate managers. Furthermore, managers, 
administrators and users may drill-down through account information, bill or statement 
data within the application interface. Users can page through bill details, sort across 
pages, sub-total and filter account information viewing dynamic reports. More complex 
reporting can be performed with edocs Analytics Manager including extensive call, cost, 
cost-center, and variance reporting. 
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Print Friendly, PDFs and Downloads 

Users may access print friendly views, request a dynamic PDF of their invoice, or select 
to download a dataset. Managers and administrators have greater access to account 
summary PDFs and datasets for the accounts they supervise. e-Billing Manager’s 
versioned, disk-efficient and high performance bill archiving feature along with its print-
friendly views makes generating hardcopy reprints quick and easy. 

Customer Service 

CSRs may create corporate administrators for an organization, thereby enrolling a 
corporate account and establishing designated internal administrators. Service 
representatives and corporate administrators may create, manage and search the business 
organizations and accounts under their supervision. The designated administrators 
accessing corporate billing statements use e-Billing Manager’s on-line self-service 
application features to manage their own organization and users. 

Key Benefits of e-Billing Manager 

Solving Business Problems 

Many billing and customer care processes today are expensive, inefficient and 
unsatisfactory for both communication service providers and their customers. With edocs 
e-Billing Manager, carriers empower their business and consumer customers to serve 
themselves, and address all their account and service-related activities online, instead of 
using expensive paper and call center based channels. For end customers, this makes 
doing business with a carrier more convenient, more efficient, and more satisfying. For 
carriers, it means improved competitive differentiation, significantly reduced customer 
care costs, increased customer loyalty, and streamlined billing/payment processing. 

By combining comprehensive online account management functionality with the world’s 
most scalable and reliable e-billing platform, e-Billing Manager enables service providers 
to gain outstanding adoption and ROI typically 5-10 times higher than companies using 
in-house, customer or competing packaged solutions. Some of the primary benefits e-
Billing Manager enables include: 

Business Benefits 

Call Center Deflection 

By enabling customers to serve themselves online, e-Billing Manager moves expensive 
call center interactions (globally these costs translate to $5-$10 USD per consumer 
interaction; $10-$30 USD per business customer interaction) to the web site where costs 
run at less than $1 USD per interaction. 



Preface 

18  |  e-Billing Manager Presentation Design Guide 

Reduced Paper, Printing and Postage Costs  

In countries where paper turn-off is a legal option, providers are saving enormous 
printing, post-age, reprint and logistical costs. Even when rules do apply, to guarantee 
postage revenues, paper may be reduced for reprints services and logistical savings 
realized. 

Streamlined Payment Processing 

Online payments are proven to reduce payment time as well as errors associated with 
them. In addition, it is less expensive for the carrier to process an electronic payment 
when compared to all the manual handling required to process a paper-based payment. 
Online payment eliminates lockbox fees, minimizes exception processing, and replaces 
the costly and time-consuming procedure of processing paper checks. 

 

Some recent metrics:  

• Adoption: 5%-60% 

• Percentage paying: 30%-85% 

• Savings per transaction: $0.11 -$1.08 USD 

Given these numbers, an attractive ROI can be rapidly achieved. 

Improved Days Sales Outstanding (DSO) 

By making statements easier to access and read, and speeding approval cycles, e-Billing 
Manager reduces the time it takes for customers to pay their bills. This improves cash and 
reduces DSO. 
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Increased Customer Satisfaction (Reduce Churn) 

By providing the option for 24/7/365 online service, carriers make it more convenient and 
more satisfying for their customers. Although somewhat more difficult to measure, 
increased customer satisfaction may ultimately be the most critical differentiator. This is 
particularly true in the B2B world of electronic invoice presentment and payment (EIPP). 
As evidenced by an independent AMR Research report, “The ROI exercise that generally 
launches EIPP projects cites process automation and cash f low as key benefits, but the 
biggest appeal of electronic billing, as it is used today, is its account management and 
customer support functionality. In reference to calls we conducted, edocs users remarked 
that the main benefit of implementing EIPP is the dramatic improvement in customer 
service they can provide. In some cases, where the supplier took the extra step of helping 
customers incorporate EIPP into A/P workflows, satisfaction went through the roof. 
Reduction in DSO and paper-based billing costs – the quantifiable benefits of EIPP – 
paled as suppliers basked in the warm glow of happy customers.” In today’s economy of 
high customer acquisition costs, providing a robust online account management and 
electronic payment experience is critical to doing business and keeping your existing 
customers satisfied. 

Application Benefits 

e-Billing Manager is a packaged enterprise software application with support, training, 
and regularly scheduled product enhancements and upgrades. Standard deployments are 
predictable and deliver “quick wins” for the service provider. 

Modularity 

e-Billing Manager may be deployed and additional e-Billing Manager Suite applications 
added to the deployment, all using the complementary edocs platform services. 

Open Standards Based 

e-Billing Manager is built on a Java 2 Enterprise Edition (J2EE ™) architecture making it 
highly scalable and flexible. Based on leading Java standards like Enterprise Java Beans 
™ ((EJB ™), Java Server Pages ™ (JSP ™), and Java Servlet application programming 
interfaces (APIs), users of e-Billing Manager can leverage all the sophisticated 
application management tools, enterprise-class performance, scalability, portability, and 
easy extensibility this environment provides. The edocs applications presentation layer 
use struts and tiles standards and may be easily “re-skinned” for branding, 
internationalization, or customized look and feel.  
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Proven Scalability 

e-Billing Manager has a linearly scalable architecture that supports millions of complex 
accounts and thousands of concurrent users. Its flexible data access layer provides for 
truly massive scalability in a way no competing architecture can claim. In fact, data 
volumes do not impact the real-time performance of the core edocs solution at all. This 
means organizations can retrieve, process, and archive tens of millions of accounts, but 
only need to scale the application server tier to handle the growing user adoption. These 
services scale linearly, meaning the platform can easily be extended to accommodate 
growth in volumes, users, or additional application services. Independent scalability 
reports from Sun Microsystems and IBM that demonstrate this power can be provided 
upon request. 

Ease of Deployment 

The off line authoring components of the e-Billing Manager Suite visual development 
environment provide menus and wizards that dramatically reduce the time required to 
configure and deploy e-Billing Manager Simulation capability is built-in allowing 
developers to test designs prior to deploying an application. Early testing lowers risks and 
costly late changes. Through the intuitive, easy-to-use graphical development 
environment, users can analyze the data sources, define the essential data, map the 
account data to presentation templates, and define business rules for one-to-one 
marketing and customer service messaging. Designers can create any aspect of account 
presentation for the Web, wireless, or other delivery devices. 

Unmatched Data Access Flexibility 

edocs provides a flexible Business Services Layer (BSL) that can leverage a wide variety 
of data sources for account information/Tariff analysis. Extensible APIs provide a full 
suite of integration services for robust comprehensive functionality. Simply stated, e-
Billing Manager transforms account data for Internet consumption. But e-Billing 
Manager is not a simple data translation application: it re-purposes available account 
data, dynamically retrieving only the information required for the new presentation 
media. 

Simple Integration 

e-Billing Manager preserves investment in and extends capabilities of existing 
infrastructure through enterprise wide integration. The edocs design environment allows 
designers to develop and integrate custom features with existing system processes into 
the Customer Self-Service solution. Integration of custom functionality or external legacy 
systems can be accomplished quickly and easily using standard tools and technologies. 
edocs eXtensible Modular Architecture (XMA) and Platform Service’s APIs are Java-
based with XML-interfaces detailed in the e-Billing Manager Software Developer’s Kit 
(SDK). Integration is straightforward for linking existing enrollment and authentication 
systems, payment processing, order management processes, accounts receivable systems, 
customer service and CRM systems, middleware infrastructure, and third-party 
operational tools. 
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Operational Oversight 

The Command Center console provides a single production management browser 
application for the e-Billing Manager Suite including scheduling of services, statement 
and account application configuration, customer statement notification configuration, 
auditing and event logging with general system administration and reporting.  

Proven Performance 

e-Billing Manager delivers superior performance without regard to data volumes or user 
loads. 

Multiple Communication Channels 

e-Billing Manager supports a multi-channel deployment paradigm for data delivery via, 
HTML, XML, IVR, PDF, Email, and devices. 

Personalization 

Any e-Billing Manager application view (or the entire template itself) can be replaced or 
modified based on business logic. By leveraging the account information contained in the 
data stream, e-Billing Manager can present highly personalized and dynamic views of a 
customer’s account. Designers define logical expressions based on actual account data 
that will modify the presentation to the customer. This means that all account data can be 
used as variables in the dynamic of the rendered account view. The mapping of data 
elements to logical expressions is encapsulated in an XML file used at run-time. 

Architecture Benefits 

Reduced Storage Requirements 

Competing approaches generally only offer transforming and storing statement data as 
XML or as normalized rows and columns in a database. The XML tags, which need to be 
stored as part of the data file, can increase file sizes by 30-40% in most cases. edocs 
solution may store data in native file formats, and convert it to delivery formats 
(including XML) only on-demand. This dramatically reduces storage requirements. Data 
compression may also be optionally provided to further reduce storage by a ratio of 
greater than 3:1. 
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A Tunable Application 

Billing information is the corner stone of any Customer Self Service solution, it is the 
data held within the bill that affects the bottom line of a customer’s business or a 
consumer’s likelihood to delay payment or switch providers. e-Billing Manager manages 
arriving bill data, processes it for storage, and archives the statement files into an 
extensible statement repository. A data store of account tables are also maintained in a 
relational database along with user management information and logging and tracking 
information. This data store may be “dialed down” using a lightweight metadata index to 
dynamically access statements, or “dialed up” creating a content repository of billing 
data. e-Billing Manager offers this option of loading bill detail or account summary 
information into a content repository for sophisticated customer reporting and analysis. 
The e-Billing Manager application and platform is therefore “tunable,” providing a 
flexible approach to managing account-based communications for multi-channel 
delivery. 

Reduced Database Licensing Requirements 

edocs data store generally comprises only 3% of the size of the raw statement data. 
Competing architectures, on the other hand, require a massive database deployment as the 
full content of each statement is stored as database rows. Database licensing implications 
can therefore add a significant cost load to competing solutions.  

Enhanced Performance and Memory Management 

edocs utilizes dynamic data extraction and transformation for presentation of statement 
data. In addition, individual statements are decomposed into “views” such as summary, 
detail, sub-accounts, etc. Only the view being requested by the user is extracted and 
transformed. By carefully tuning view size, the developer retains complete control over 
the application’s real time performance profile. 

Improved Reliability and Data Quality 

Competing architectures require batch data transformation to convert data formats. Any 
time data transformation occurs, there is a risk of user or system error where data will be 
“left on the cutting room floor,” improperly truncated, or generally mis-mapped. Since 
transformation occurs in large-scale batch jobs, error recovery is very expensive. In the 
case of error, all of the errant data needs to be identified and purged from the database, 
the source data needs to be recreated, transformation rules corrected, and the batch jobs 
rerun. If the batch cycle is long, the correction may be impossible if several days have 
passed before the error was detected. edocs utilizes “dynamic data transformation” 
whereby data is transformed on the fly by dynamically applying extraction and 
presentation rules. As such, if an error should occur, the rules can be fixed and re-
published on the fly without having to rerun the batch process or drop data. 
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Reduced Batch Cycle 

edocs batch cycle consists of scanning and indexing arriving batch files. Depending on 
the file format, the batch process typically runs at 7.5 GB of source data per hour. The 
process may even be configured to run parallel across server clusters for greater 
throughput. Competing architectures are simply not able to achieve this load time, 
leading to consumption of additional system resources and higher stakes for error 
recovery. 

Robust Version Management 

edocs realizes the frequency with which businesses change: new products are introduced, 
statements are redesigned, and old products are discontinued. As such, edocs makes 
extensive use of a template-based architecture and provides robust capabilities for 
versioning templates. Essentially, rules for transforming and presenting data are 
versioned by date and stored with the source files they correspond to. As such, if a new 
service offering or bill format is introduced, a developer need only publish new templates 
which accommodate the changes and need not worry about affecting historical 
statements. Competing approaches to changing fixed relational database schemas are far 
more complicated to manage. These advantages translate in to a lower total cost of 
ownership, which offers returns every day that the system is in production. 

The EPP Suite 
edocs Electronic Presentment and Payment (EPP) Suite is a set of modular applications 
that include every capability organizations need to enable a complete online account 
management experience. The suite is comprised of four packaged applications: 

• e-Billing Manager 

• e-Payment Manager 

• e-Statement Manager 

• EasyPay 

The suite combines the industry’s most comprehensive e-billing, e-invoicing and e-
payment functionality with edocs extensive industry experience. These out-of-the-box 
applications have been deployed in some of the most challenging business and technical 
environments worldwide and are proven to be the industry’s most scalable and reliable. 
As a result, edocs customers consistently gain the highest customer adoption and ROI in 
their industries -- often five, ten, even twenty times higher than companies using in-
house, custom or competing packaged solutions. 
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e-Billing Manager 

edocs e-Billing Manager gives consumer and business customers’ valuable and 
convenient online access to their bills or invoices, along with the ability to easily make 
online payments. Bills and invoices encapsulate all of the activity and charges associated 
with the exchange of goods or services between a customer and an organization and as 
such, are at the foundation of the relationship. 

• HTML Presentment 

• Drill-down 

• Consolidated View 

• Bill/Invoice Archiving 

• Paper Turn-off Support 

• Printer-friendly Views 

• Reporting 

• Targeted Messaging 

• Proactive Advanced e-Care 

• Notifications 

• Profile Management 

• Electronic Payments 

• Payment Scheduling 

• Payment Status and History 
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• Accounts Receivable Reconciliation 

e-Statement Manager 

edocs e-Statement Manager enables organizations to deliver interactive and personalized 
electronic account statements to both business and consumer customers. The application 
provides a more cost-efficient way to present current and archived statements online. 
Organizations, especially financial institutions and healthcare insurance carriers, are 
deploying e-statements as part of a comprehensive online customer care strategy. 

Realizing that not all customers require paper statements and that many prefer to access 
their account information online in a more convenient and valuable way, organizations 
are switching to the online model and are reaping the benefits. 

• HTML and PDF Presentment 

• Statement Consolidation 

• Drill-down 

• Statement Archiving 

• Printer-friendly Views 

• Paper Turn-off Support 

• Reporting 

• Targeted Messaging 

• Proactive Advanced e-Care 

• Notifications 

• Profile Management 

e-Payment Manager 

edocs e-Payment Manager is a complete solution for electronic payments executed by 
customers enrolled in e-billing and e-invoicing. It plugs into existing applications and 
systems, preserving investments in, and extending the capabilities of existing 
infrastructure. With edocs e-Payment Manager, organizations decrease payment-
processing costs, accelerate receivables, and improve operational efficiency in the areas 
of billing and collections, customer service and treasury management. 

EasyPay 

edocs EasyPay is a convenience payment solution that enables organizations to integrate 
web, response (IVR) and contact center payment channels to accept one-time, often last 
minute, using a wide range of payment instruments, eliminating the existence of multiple 
technology “silos” that are often used to collect payments from customers. 

• Web, CSR, and IVR-based Payment 
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• Payment Scheduling 

• Summary View 

• Drill-down 

• Error and Fraud-Prevention 

• Multi-lingual Interfaces 

• Reporting and Auditing 

• Organizational Branding 

• Hosted and In-house Deployment Models 

e-Service Applications 

Whether customers are visiting an organization’s web site, communicating by email, or 
seeking to chat real-time with a CSR, edocs e-Service Applications ensure the ability to 
deliver knowledgeable and exceptional customer service. Driven by sophisticated 
intelligence engines and automation technologies, these solutions replicate the knowledge 
of an organization’s most experienced personnel, providing timely, accurate responses to 
customer inquiries. 

e-Mail Manager is an automated e-mail response management system that determines 
the intent of the incoming e-mail messages and composes personalized answers that can 
be automatically dispatched to customers or routed to service agents for a single-click 
review. 

Intelligent Assistant is an advanced natural language-based self-service application that 
empowers customers, prospects and customer service representatives (CSRs) to leverage 
all of an organization’s knowledge assets-web pages, account data, documents, databases, 
existing legacy data sources, and knowledge bases to quickly and accurately find answers 
to their specific billing, account, product and service questions. 

Extended Customer Service Modules 

edocs’ Extended Customer Service Modules augment edocs core e-billing and online 
self-service capabilities and extend them to additional users, channels and endpoints. This 
enables organizations to provide more effective and efficient service regardless of what 
service channel customers choose. 

Print Manager is a complete solution for data consolidation, visual statement formatting 
and design, and print output generation that significantly reduces the cost and complexity 
of producing paper bills, invoices and statements. edocs combined electronic and print 
output solution handily solves the challenge of account consolidation avoiding the need 
to alter complex back-end legacy systems to present a consolidated account view online 
or on paper.  
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Syndication Manager is an account content distribution system that handles all the 
complexities of securely distributing summary account information to any endpoint, 
while also enabling customers to go back to the billing organization’s website to take 
advantage of more comprehensive self-service capabilities. 

CSR Manager enables customer service representatives (CSR) to access critical account 
data and service-related information and capabilities to effectively service both online 
and off line customers. CSR Manager is a browser-based application that couples 
traditional customer-facing online self-service capabilities with CSR-specific features 
including case management, facilitating better service at the point of customer contact. 

Marketing Manager is a personalization, campaign and content management solution 
that weaves personalized marketing and customer service messages based on specific 
account information throughout the customer self-service and e-billing experience. The 
browser-based application facilitates collaboration between internal marketing and 
customer service departments as they create, deploy and track the performance of 
campaigns. 

The edocs Advantage 

edocs EPP Suite has the lowest total cost of ownership (TCO) of any self-service 
approach. It provides an optimal TCO because of the following key attributes: 

User Scalability - edocs platform demonstrated unparalleled scalability and performance 
in testing by IBM and Sun. The platform routinely supports millions of accounts and 
online users without performance degradation for edocs individual global 2000 customers 
around the world. This translates into less hardware and lower IT costs for edocs 
customers. 

Standards-Based - edocs J2EE standards-based platform and modular component 
architecture meets the demanding requirements of leading organizations. 

Integration - edocs ’ EPP Suite integrates with existing infrastructure including web 
portal, call center, IVR and other enterprise applications to maximize the solution ’s ROI. 
The application uniquely accesses a variety of diverse data sources (e.g. legacy, print 
source, data warehouse) that most applications cannot, providing a consolidated view of 
customer accounts. 

Time to Market - edocs EPP Suite allows for rapid deployment because it comes as a 
complete packaged, out-of-the-box application that is tailored to solve distinct business 
problems and meet industry specific process requirements. 

Conclusion 
edocs e-Billing Manager is the proven software platform for scalable, high-performance 
self-service and e-billing applications that enable organizations to manage account 
relationships with business and consumer customers online. e-Billing Manager 
application solutions: 

• Reduce support and processing costs 
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• Improve operational effectiveness 

• Increase customer satisfaction 

• Enhance marketing effectiveness 

e-Billing Manager’s out of the box consumer and business applications for data access, 
online account composition, analytics, one-to-one messaging, and business hierarchy 
dramatically decrease time to market for deploying self-service solutions. Developed on 
J2EE technology, the e-Billing Manager platform is flexible, extensible, and easy to 
manage, and is the proven platform for online consumer and business applications. 

e-Billing Manager leverages available data from transactional systems to dramatically 
reduce the costs associated with producing, delivering, and paying account 
communications, while simultaneously transforming accounts into dynamic, interactive 
self-service and marketing tools.  

e-Billing Manager goes far beyond bill presentment solutions providing packaged 
applications with many e-billing features, including online account and statement 
composition, payment, business logic, one-to-one marketing, hierarchy, customer service 
access, and service messaging with application management. 

e-Billing Manager’s EJB platform architecture has been proven scalable in production 
and through independent testing. This is a key differentiator in comparing packaged 
solutions. 

Finally, because of e-Billing Manager’s flexibility and methodology, time to market with 
an e-Billing Manager Suite solution is extremely rapid, stable, and scalable resulting in a 
total cost of ownership lower than competing or home grown solutions. 

About This Guide 
This guide is intended for system administrators or other IT professionals responsible for 
setting up and running a live e-Billing Manager application in a J2EE environment. It 
describes the general process and specific procedures required to: 

• Set up a new e-Billing Manager application and the associated jobs using the edocs 
Command Center. 

• Produce regular online statements electronically and manage the ongoing live 
production process. 

This guide assumes you have: 

• Installed e-Billing Manager in your J2EE environment. 

• Designed and developed the necessary application files (using DefTool and 
Composer in a Windows 2000 environment). 

This guide does not describe general UNIX or Windows system administration. See the 
appropriate UNIX or Windows user documentation.  
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Related Documentation 
The following online Help is available in the edocs Command Center: 

 

Online Help How to Access 

Comprehensive Command 
Center Help 

Click Help on the Command Center menu. Help contains 
additional information about administering your application 
in a live production environment. 

Screen-level Command 
Center Help 

Click the Help button on a screen for details about that 
particular screen. Click Help Contents there to access 
the complete administration Help. 

A PDF version of this guide A PDF version of this document is located on your product 
CD.  

This guide is part of the e-Billing Manager documentation set. For more information 
about implementing your application, see one of the following guides: 

 

Print Document Description 

e-Billing Manager Installation 
Guide 

How to install e-Billing Manager and configure it in a 
distributed environment.  

e-Billing Manager 
 Data Definition Guide 

How to create Data Definition Files (DDFs) for use in 
indexing your application and extracting data for live 
presentment. 

e-Billing Manager Presentation 
Design Guide 

How to create Application Logic Files (ALFs) to 
present statement data for dynamic online display. 

Obtaining edocs Software and Documentation 
You can download edocs software and documentation directly from Customer Central at 
https://support.edocs.com. After you log in, click on the Downloads button on the left. 
When the next page appears, you will see a table displaying all of the available 
downloads. To search for specific items, select the Version and/or Category and click the 
Search Downloads button. If you download software, an email from edocs Technical 
Support will automatically be sent to you (the registered owner) with your license key 
information. 

If you received an edocs product installation CD, load it on your system and navigate 
from its root directory to the folder where the software installer resides for your operating 
system. You can run the installer from that location, or you can copy it to your file 
system and run it from there. The product documentation included with your CD is in the 
Documentation folder located in the root directory. The license key information for the 
products on the CD is included with the package materials shipped with the CD. 
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If You Need Help 
Technical Support is available to customers who have an active maintenance and support 
contract with edocs. Technical Support engineers can help you install, configure, and 
maintain your edocs application. 

This guide contains general troubleshooting guidelines intended to empower you to 
resolve problems on your own. If you are still unable to identify and correct an issue, 
contact Technical Support for assistance.  

Information to provide 

Before contacting edocs Technical Support, try resolving the problem yourself using the 
information provided in this guide. If you cannot resolve the issue on your own, be sure 
to gather the following information and have it handy when you contact technical 
support. This will enable your edocs support engineer to more quickly assess your 
problem and get you back up and running more quickly. 

Please be prepared to provide Technical Support the following information: 

Contact information: 

• Your name and role in your organization. 

• Your company’s name 

• Your phone number and best times to call you 

• Your e-mail address 

Product and platform: 

• In which edocs product did the problem occur? 

• What version of the product do you have? 

• What is your operating system version? RDBMS? Other platform information? 

Specific details about your problem: 

• Did your system crash or hang?  

• What system activity was taking place when the problem occurred? 

• Did the system generate a screen error message? If so, please send us that message. 
(Type the error text or press the Print Screen button and paste the screen into your 
email.) 

• Did the system write information to a log? If so, please send us that file. For more 
information, see the e-Billing Manager Troubleshooting Guide. 

• How did the system respond to the error? 

• What steps have you taken to attempt to resolve the problem? 

• What other information would we need to have (supporting data files, steps we’d 
need to take) to replicate the problem or error? 
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• Problem severity: 

• Clearly communicate the impact of the case (Severity I, II, III, IV) as well as the 
Priority (Urgent, High, Medium, Low, No Rush). 

• Specify whether the problem occurred in a production or test environment. 

Contacting edocs Technical Support 

You can contact Technical Support online, by email, or by telephone. 

edocs provides global Technical Support services from the following Support Centers: 

US Support Center 
Natick, MA 
Mon-Fri 8:30am – 8:00pm US EST 
Telephone: 508-652-8400 

Europe Support Center 
London, United Kingdom 
Mon-Fri 9:00am – 5:00 GMT 
Telephone: +44 20 8956 2673 

Asia Pac Rim Support Center 
Melbourne, Australia 
Mon-Fri 9:00am – 5:00pm AU 
Telephone: +61 3 9909 7301 

Customer Central 
https://support.edocs.com 

Email Support 
mailto:support@edocs.com 

Escalation process 

edocs managerial escalation ensures that critical problems are properly managed through 
resolution including aligning proper resources and providing notification and frequent 
status reports to the client.  

edocs escalation process has two tiers: 

1. Technical Escalation - edocs technical escalation chain ensures access to the right 
technical resources to determine the best course of action. 

2. Managerial Escalation - All severity 1 cases are immediately brought to the 
attention of the Technical Support Manager, who can align the necessary resources 
for resolution. Our escalation process ensures that critical problems are properly 
managed to resolution, and that clients as well as edocs executive management 
receive notification and frequent status reports. 
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By separating their tasks, the technical resources remain 100% focused on resolving the 
problem while the Support Manager handles communication and status. 

To escalate your case, ask the Technical Support Engineer to: 

1. Raise the severity level classification. 

2. Put you in contact with the Technical Support Escalation Manager. 

3. Request that the Director of Technical Support arrange a conference call with the 
Vice President of Services. 

4. Contact VP of Services directly if you are still in need of more immediate assistance. 
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What is Composer? 
Composer is the GUI design tool you use to map the data extracted from your data input 
file to an HTML template for online presentation. 

The result of using Composer is an Application Logic File (ALF) for your application 
and an edited version of one or more HTML templates. 

When a customer makes a request to view a statement in a live e-Billing application, the 
e-Billing server uses the information in the ALF to locate the associated DDF, HTML 
template, digital images, and the data input file for extracting and present the statement. 

After Creating an e-Billing Manager Application 
When you are finished using DefTool and Composer to create your application, refer to 
the e-Billing Manager Administration Guide for instructions on how to use the edocs 
Command Center to implement and run an application in a live production environment. 
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Before Creating an Application Logic File (ALF) 
You must create the following files for your application before you can begin using 
Composer to create the rules for statement presentment: 

• The Data Definition File (DDF) using DefTool 

• The HTML templates you plan to use for presentment 

You must create a separate ALF for each application view. Become familiar with the 
different views your application requires before starting to create ALFs. 

Steps to Create an ALF 

To create an ALF: 

1. Run Composer. From the Windows Start menu, select 
Programs>edocs>Composer. 

2. Create a new ALF. Associate the new ALF with the DDF. 

3. Define the default template for the view (ALF). 

4. Map field, table, and group definitions to your template. Composer displays all 
the data definitions from your DDF in a tree and lets you click and drag the 
definitions onto your HTML template. Be sure to work in the WYSIWYG template 
view. 

5. Format mapped fields and tables. Composer lets you specify font and cell 
properties. 

6. Customize the ALF to present the email notification or statement data as needed: 

• Add content. Content can include images, text, hyperlinks, HTML code, HTML 
statement templates, and certain table formatting. 
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• Create any simple or complex data-driven conditions (business logic, called logic 
elements) on sections or tables in the statement. A condition contains the data-
based business logic that determines which image, text, HTML code, HTML 
template, or conditional table formatting to display.  

• Specify the HTML template to use for each occurrence in a statement. 

• Create any sort, paging, filter, combine, or arithmetic elements and add 
corresponding element hyperlinks.  

• Add any conditional templates or switch ALFs. 

7. Use the Simulator to view the composed sample statements. Simulator lets you 
see how the composed view will appear in a browser. This lets you make necessary 
changes without running the production jobs to test the application. 

8. Save your ALF and the HTML templates.  

9. Create any additional ALF your application requires (if any) 

A completed ALF contains all the information about how to assemble an email or 
statement view. Composer adds e-Billing Manager-specific tags into the HTML 
templates during the ALF creation process, indicating where data should be modified and 
where logic arguments need to be applied. The actual logic arguments, as well as other 
assembly instructions, are stored in the ALF. 

Once you have finished creating your application ALFs, you can proceed to test and 
implement your application in a live production environment. See the e-Billing Manager 
Administration Guide. 

Saving the ALF, HTML Template Files 

Whenever you make changes to the composition rules in an ALF, you must save the 
ALF. Whenever you save the ALF, Composer automatically saves the open template file 
as well. You can save the template independently, however.  

See “Completed ALF and HTML Application Files” on Page 37 for details about the 
features saved in each file. 

To save the ALF (and HTML template): 

• Select File>Save Alf or click  on the ALF toolbar. 
 

Tip
 

Since the ALF is an XML file, you can edit it in a text or XML editor. 
However, make sure syntax is correct, or you won’t be able to open the an 
ALF in Composer and problems can arise during production. 

To save the HTML template only: 

• Click  on the Template toolbar. (Be careful not to click the ALF save icon, 
shown above; the Save Template icon has the letter “T” on it.) 
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Tip
 

Giving each template revision a “template ID” comment in the HTML 
template that indicates (matches) the dated directory in which the template 
resides can be helpful when troubleshooting. 

 

Completed ALF and HTML Application Files 

Be sure to save your ALF whenever you make additions or changes to composition rules. 
Whenever you save an ALF, Composer automatically saves the open template as well. 
(You can save the template independently.) 

A complete ALF contains the following information: 

• File path/name of the associated DDF 

• Version of e-Billing Manager 

• File path/name of the associated default HTML template 

In addition, a complete ALF includes the following information for any features you add, 
including:  

• Content name for: 

• Switch ALFs 

• Alternate HTML statement templates (conditional templates) 

• HTML group templates 

• Business logic-driven content containing images, text, or HTML files 

• Conditional statements containing business logic 

• Logic elements (pieces of comparative logic you use in conditions) 

• Group assembly statements 

• Table formatting information 

• Sorting configuration details (sort elements) 

• Paging configuration details (page elements) 

• Filter configuration details, including top/bottom filters (filter elements) 

• Arithmetic elements to sum a column or count rows in a table 

• Configuration details to combine tables for paging or sorting (combine elements) 

The completed HTML template can contain the following e-Billing Manager application 
features: 

• Tags for mapped fields, tables, groups, and charts 

• Formatting (except table formatting, which is saved in the ALF) 
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• Open and close tags for sections of HTML on which you create one or more 
conditions 

• Links to sort, page, and filter elements 

• Links to subsequent views, such as a detail view. 

See also “Saving the ALF, HTML Template Files” on Page 36. 

The Composer Interface 
The Composer interface consists of: 

• Menus 

• Toolbars 

• Application and Definition Trees on the left 

• The open HTML template on the right 

The Trees, menus, and toolbars often provide more than one way to select a Composer 
feature or perform a task. 

  

Application and Definition Trees 

The left side of the Composer window lets you alternately display either of two trees that 
let you add data to your statement or create additional features for presentment: 



Overview of Creating an ALF 

e-Billing Manager Presentation Design Guide  |  39 

• Application Tree – The Application tab displays a list of composition rules and 
features that have been created in the Application Logic File (ALF), such as any 
switch ALFs or alternate HTML templates added, conditions on sections, content, 
logic elements, and sorting, paging, filtering, arithmetic, or combine elements. You 
can right-click on categories and items in the Application tree for a shortcut to 
creating new features (such as new content) or other design tasks. The Application 
tree is empty for a new ALF. 

• Definition Tree – The Definition tab displays an expandable list of all data fields, 
tables and groups defined in the associated Data Definition File (DDF). You can 
click and drag items from the Definitions tab to the HTML Template area to map 
these items to the statement for presentation. 

The Application Tree tab appears on the left, the Definition Tree tab on the right: 

  

To switch between trees: 

• Click the  or  tab. 

To expand or collapse a tree node: 

• Double-click the node name or click the plus (+) or minus (-) sign in front of the node 
to expand or collapse the list of items.  

Collapsed: 
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Expanded: 

 

HTML Template Area 

The open HTML template appears in the right pane of the Composer window. Use this 
work area to view and edit your statement graphically in WYSIWYG (what-you-see-is-
what-you-get) mode:  

 

You can switch to HTML mode to view and edit the source HTML:  

 

To switch HTML template edit mode: 

• Click the  or  tab. 
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Menus 

File Menu 

The Composer File menu let you open, close, or save your current ALF and associated 
HTML template files, or access recently opened ALFs directly. 

Edit Menu 

Use the Edit menu for standard edit and text search functionality in HTML or 
WYSIWYG mode, including Undo and Redo actions on the template. 

Insert Menu 

The Insert menu lets you insert images, anchors (bookmarks), or HTML text in the 
template, or create content or logic elements. You can also insert the character set tag into 
the HTML template for internal reference (see “Using Encoded Character Sets in the 
HTML Templates” on Page 84 for details). 

Format Menu 

Use the Format menu for standard formatting options such as style, font, alignment, 
indent and bulleted and numbered lists. You can use it to directly edit the HTML 
template. 

Table Menu 

Provides standard table options to insert and edit HTML tables in your template (not the 
data tables you map from your DDF). 

View Menu 

Use the View menu to define which Composer panes and toolbars you want to view 
(toggle on/off), view a list of conditions, logic elements, or content, go into edit mode, or 
select the Simulation options.  

The ALF Objects Bar option displays/hides the Composer Application and Definition 
Trees. (You can also right-click on the white space in the trees and click the Hide button 
that appears.) 

Window Menu 

The Window options provide standard tile and cascade capabilities. 

Help Menu 

The Help menu provides access to online help topics for Composer and the product 
About box. 



Overview of Creating an ALF 

42  |  e-Billing Manager Presentation Design Guide 

Toolbars 

The Composer includes several toolbars, shown below, containing icons that let you 
quickly access many key functions. To find out what an icon represents, hold the mouse 
over the icon and the Quick Help description appears. 

 

ALF Toolbar 

The ALF toolbar icons let you to perform functions associated with the ALF. You can 
create a new ALF, opening an existing ALF, save the file, create a switch ALF condition, 
change the associated DDF, view a list of conditions, contents, or logic elements, add a 
conditional template, or view the Composer About box.  

 

Template Toolbar 

The Template toolbar icons affect the open template file. You can open a template, save 
changes, cut/copy/paste items to it, print, or toggle in and out of edit mode. 
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Formatting Toolbar 

Use the Formatting toolbar icons to format the template. You can apply various character 
and paragraph formatting, including bold, italics, underline, color, numbering, bullets, 
justification, and indents. Use the Style Format icon to apply a variety of formatting. 

 

Object Toolbar 

The Object toolbar icons let you insert graphics or hyperlinks into the template (first 
select an object on the template to associate a hyperlink with it).  

 

Simulator Toolbar 

The Simulator toolbar icons let you use a test data file to view the statements as they will 
appear composed in a browser. You can page backward and forward through multiple file 
documents, verifying that the conditional logic is defined correctly and that all values 
map correctly.  
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For a View that is Not a Sub-Account 

To create a new ALF (statement or email notification): 

1. Maximize the Composer window.  

2. Select File>New ALF or click the New Document  icon. The New Application 
Logic File window opens. 

 

3. Click Browse and select the appropriate path to the DDF associated with the ALF. 
(If the selected DDF has a subkey group field, the Use Sub-document option 
becomes active; you must select this option for a view designed to present a sub-
document. See “For a Sub-Account View” on page 46.) 

4. Click Create. The Create Alf File As dialog opens. 
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5. Verify that the Save In field points to the correct folder and enter a meaningful name 
for the ALF.  

6. Click Save. The New Application Logic File dialog reappears. 

7. Click OK. The new ALF appears in the Application Tree. 

For a Sub-Account View 
To use the sub-document indexing feature you must create and use a separate 
Application Logic File (ALF) for presenting a sub-document view.  

You must also map the group and subkey to the default template. (You do not need to 
specify a group template for the sub-documents; the group becomes the main document 
in this view.)  

To create a new sub-account ALF and map the data for presentment: 
1. In Composer, select File>New ALF. Composer displays the New Application Logic 

File dialog. Select the application DDF you created for this view. 
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2. Select the Use sub-document option. Composer displays a tree showing the sub-
document groups in the DDF. 

 

3. Click on the Groups node to expand the list. Select the group containing the subkey 
for the sub-account you want to use in this ALF view. 

4. Click Create. The Create Alf File As dialog opens. 
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5. Verify that the Save In field points to the correct folder and enter a meaningful name 
for the ALF. 

6. Click Save.  

7. Click OK. Note that in the Definition Tree, Composer converts the sub-document 
group into pure tables, fields into pure fields, and the subkey to the primary key. 
Composer treats the sub-document as a normal document, not a group (and there is 
no group template for the group). 

Specifying a Default Template 

To specify a default template for a statement or email notification ALF: 

1. Right-click the  Home icon in the Application Tree.  

2. Select Add Default Template from the right-click menu. The New Default 
Template dialog opens. 

 

3. Click the  button next to the Default Template Path. The Open dialog appears. 

4. Select the HTML template you want to use as the default.  
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5. Click OK. The template appears in the work area of Composer, and Default_Template 
appears under the Home node in the Application Tree.  
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Mapping Fields to the Template 
After creating an ALF and specifying the default template, you can map the data fields 
defined in the DDF to the template for presentment. (You can also map fields to any 
conditional HTML templates added). 

To map data fields to a statement or email notification template: 

1. Click the  tab in the Work Area (if not there already) to display the 
Default HTML template graphically. 

2. Click the  tab in the Tree area and double-click the  Fields node 
to expand the list of items in your DDF, for example: 

 

3. Click the field you want to map, then drag and drop it where you want it to appear in 
the template. (Fields in the template appear as [E]Fieldname,F[/E]. The field 
assumes the properties of the area in which you place it. “F” indicates the element is 
a field.) 
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4. Add any field formatting you want. To format a field, highlight the entire field tag, 
including the [E] and [/E] tags, and use the Format menu or the Formatting toolbar 
to apply HTML formatting.  

5. You can optionally add a notification link to the template. A notification link creates 
a direct link to the production web server, based on the configuration settings in the 
edocs Command Center. See “Mapping a Notification Link” on Page 83 for details. 

6. If your HTML template used “XX” placeholders for fields or tables, delete them. 
Select Edit>Find Text to search the HTML for any placeholders; verify that 
you’ve mapped all the required values to the template and deleted all the 
placeholders. 

7. Click the  icon to run the Simulator and check your work. Make any changes 
necessary, running Simulator as often as needed. 

 

8. Click the Save Template  icon to save the changes to your template. 

Note that if you delete a field, table, or group from the DDF (using DefTool) after 
mapping it to an HTML template in Composer, you must manually delete the associated 
tag in the template. 

Inserting Images, HTML Code, Hyperlinks, or HTML 
Tables 

You can insert images, HTML code, hyperlinks or HTML tables into the statement 
template. 
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To insert an image: 

1. With the ALF and statement template open in Composer, place the cursor on the 

template where you want to insert the image, and click  or select 
Insert>Picture. The Picture dialog appears. 

 

2. Click Browse and select the image. 
 

Caution
 

When referencing images or other files in the template, don’t use literal 
paths, such as “img src=c:\images\logo.gif”. Instead, use URL addresses, 
such as: 
http://www.edocs.com/images/logo.gif 

3. Enter any text to use as a possible alternative to the image. 

4. Specify the layout and spacing information and click OK. 

To insert hyperlinks: 

1. With the ALF and statement template open in Composer, select the text or object to 
use for the link. 

2. Click  or select Insert>Anchor. The Hyperlink dialog appears. 

 

3. Choose the hyperlink type and enter its URL information.  

4. Click OK. Text links appear underlined and blue in the template. 
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To insert HTML tables: 

1. With the ALF and statement template open in Composer, place the cursor in the 
desired location and select Table>Insert Table. The Insert Table dialog appears.  

 

2. Specify the number of rows and columns. 

3. Specify the table attributes. 

4. Specify the cell attributes. 

5. Enter a table caption, if desired. 

6. Click OK. 

To insert HTML text: 

1. With the ALF and statement template open in Composer, place the cursor in the 
desired location and select Insert>HTML. The Insert HTML dialog appears. 

 

2. Enter the text, with any HTML commands. 

3. Click OK. The text appears. 

Creating Conditions 
Composer lets you specify data-driven conditions that can instruct e-Billing Manager to 
do one of the following when composing an individual statement or email: 

• Use an alternate ALF (switch ALF condition) 
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• Use an alternate HTML template for presenting the statement 

• Insert or use alternate images, text, or HTML file in a section of a statement or in an 
individual table row (conditions on a table can also include font and cell formatting) 

For example, you could define a condition that causes a different HTML template to be 
used depending on the value in the total amount field of a statement. You can target 
marketing campaigns and promotions to specific users based on the data in their 
statement.  

In addition, a non-data driven condition on a table can apply formatting and content to a 
select pattern of rows. 

The Composer interface lets you build the conditional statements by selecting the 
individual operators, logic elements, content, etc. Similarly, you can pick and choose 
components to create individual logic elements to use in your conditions. You can create 
and name logic elements anytime, making them available to choose from a drop-down 
list when creating conditional statements. 

Creating a condition on a table lets you add images, links, formatting, etc. directly into 
the line of a statement, letting you focus your marketing campaign at the table data level. 
Creating a “condition on a line item” lets you format the cells or rows in an alternating 
pattern you define. See Chapter 4 for information about using conditions on tables. 

A simple conditional statement takes the form: 
IF (logic element) THEN content 

For example: 
IF (B2Ccustomer) THEN B2CMessage 

Creating a condition on a section adds <EDOCSSECTION = SECTIONNAME> open and 
close tags to the HTML template.  

Creating a Logic Element 

A logic element is an expression that compares the values in two data fields or between a 
data field and a specific value. You use one or more logic elements to build conditional 
statements in Composer. 

You can create logic elements while defining a condition or create logic elements first, 
making them available to select from a drop-down list when creating the condition. You 
define and save logic elements with a name, making them available for reuse in other 
conditions.  

A logic element can compare:  

• The values in two fields, group fields, or table columns 

• The value in a field, group field, or table column to a specific value such as a date, 
time, amount, NULL or EMPTY, or a regular expression  

• A table or group with NULL or EMPTY (to test for existence) 
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Content is what e-Billing Manager inserts or uses in place of something else in a 
statement when the condition is true. Content can be an image, text string, HTML section 
or HTML template within a section of a template. In tables, content can also include font 
and cell formatting; see “Creating Conditions on a Table (Line Item)”on Page 89 for a 
description of content you can apply to tables (table content). (Any alternate HTML 
templates or ALFs are “content” for those types of conditions only.) 

You can create conditions with multiple logic elements using the AND operator or the 
OR operator, for example: 

IF (B2CCustomer AND AmountDue1000) THEN B2CMessage 

Additional conditions in a statement must start with ELSE IF. 

Logic element syntax 

Each logic element requires the following information and syntax: 

• The data type; DATE, TIME, CURRENCY, INTEGER, or DECIMAL (not 
necessary for a string). 

• An open parenthesis (not needed if the data type is a string). 

• The field, group field, table, column, or group in format /BillDate[]. 

• The data format if the data type is DATE, TIME, CURRENCY, or DECIMAL. For 
DATE or TIME you must manually enter any separators, such as forward slashes in 
the date: %d/%m/%Y. 

• A close parenthesis (not needed if the data type is a string). 

• An operator for the condition; ==, != (not equals), <, >, <=, >=, ~, or TRUE, AND, 
OR or NOT. (Use the tilde “~” before a regular expression.) 

• A value to compare with the first part of the logic element. This can be another 
field, group field, table, column, specific date, time, integer, or string, or a regular 
expression, along with the data type and format (plus separators), where appropriate.  

The following examples of logic elements show a variety of logic comparisons: 
/FirstStmtIndicator[]!=NULL 

 

/CustType[]== "B2B" 

 

/SummaryInfo[]/SummaryInfoCR[]==”CR” 

 

DATE (/StatementDate[],"%d/%m/%Y")>= DATE 
("11/18/2002","%d/%m/%Y") 

 

CURRENCY (/CurrentCharges[],’.’, "")> CURRENCY(“200.00”, ’.’, 
"") 
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You can use a relative path if the section (condition) is on extracted data in the 
table/group HTML. You can use always use an absolute path. 

Creating logic elements on group fields 

You can create a logic element on sub-account group fields, including a subkey, or on a 
group field and a table column. These elements can be at different levels, but must both 
be within the same sub-account group hierarchy. 

In the case where you have nested sub-account groups, any conditions you create on the 
nested sub-account group apply only to that group and not to the higher-level, or parent 
sub-account group. Any condition you create on the parent sub-account group likewise 
applies to the parent sub-account only, and not to any nested sub-account groups. (Nested 
sub-account groups act like regular groups since they are just a subset of the parent group 
view.)  

If a condition on a group field adds a section to a group template, the group field must 
belong to that group or to a child group of the one where the section appears. The 
condition cannot add a section to a group that is a child of the group the field belongs to. 

To create a logic element: 

1. With the ALF open in Composer, right-click the  node in the 
Application Tree and select Create Logic Element from the right-click menu (or 
click the appropriate Create button while creating a condition). Composer displays 
the Create Logic Element dialog. 

  

2. Type a meaningful name for the logic element in the Logic Element box. 

3. Click  to display the buttons for selecting fields, operators, dates, 
etc. to add to the logic element. Select or enter items in the sequence you want them 
to appear in the logic element. (You can manually enter the logic element in the Add 
or Change Expression box, but choosing from the menus reduces typing and syntax 
errors.) 
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4. If comparing a field or column, click Data Type  and select the 
type of data. It is not necessary to select a data type for strings. Composer adds the 
data type and an open parenthesis to the expression: 

 

5. Click Fields,  expand the list, and select the field, table, 
column, group, or group field you want to compare. Composer adds the column name 
(and a comma, if data type is not a string) to the expression: 

 

6. If you choose a table column, the Set Occurrence Value dialog appears. Specify the 
row occurrences you want e-Billing Manager to check. To specify a basis other than 
the default (empty brackets default to Current Occurrence), click on the table name 
and edit the value between brackets [] as described here: 

• [] Current Occurrence – Evaluate each row in the table and apply the content to 
each qualifying row 

• [?N] Any N Occurrence – If N rows of qualifying data exist in the table, then 
apply the content 
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• [*] Every Occurrence – Every row must meet the condition, then apply the 
content 

• [N] N Group/Table Occurrence or Column Line – If the Nth table row qualifies, 
then apply the content 

Be sure and specify the same row occurrences on both sides of a logic element if you 
are comparing two column values. 

 

7. If the data type of the comparison field or column is a date, time, currency, or 

decimal, click Data Format  and select the format of the data. 
(For additional information about valid format strings you can enter, see Appendix 
A.) Composer adds the data format and a close parenthesis to the expression. 
Manually add any required separators. 

 

8. Click Operator  and select an operator from the drop-down list. 
(Choose the tilde “~” operator with a regular expression.) Composer adds the 
operator to the expression. 
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9. Click Data Type and select the same data type you selected in the first part of the 
logic element (if any). Composer adds the data type and an open parenthesis to the 
second part of the expression. 

 

10. Specify the field, group field, column, date, time, or value for comparison on the 
right side of the logic element expression. You can only compare groups and tables 
with NULL or EMPTY.  

• To compare the data to a field or column, click Fields and choose the field 
or column, adding any necessary separators. (Note that if you are comparing 
group fields, this field must be higher in the hierarchy than the one on the left 
side of the expression.) Composer adds the column name in quotation marks, 
followed by a comma, to the expression. 

• To specify a date for comparison, click Calendar and choose a specific 
month, year, and day. Composer adds the selected date in quotation marks, 
followed by a comma, to the expression. 

.  

• To specify a time for comparison, click Time. Click the hour, minutes, seconds, 
or AM/PM to highlight, and use the up and down arrows to specify the value: 

. When the time you want appears, double-click to enter the time 
in the expression. Composer adds the selected time in quotation marks to the 
expression. 

• To specify an integer, decimal, or string value for comparison, manually type 
the value between quotation marks followed by a comma. Add a close 

parenthesis after an integer value. (Click buttons  or type 
directly into the expression.)  



Defining Statement Presentment 

e-Billing Manager Presentation Design Guide  |  61 

• To compare a string, table, or group to NULL or EMPTY, click Value and 
select NULL or EMPTY. Composer adds the word NULL or EMPTY to the 
expression. 

11. If the data type is a date, time, currency, or decimal, click Data Format and select 
the same format you selected in the first part of the expression, manually entering any 
required separators. Composer adds the data format, followed by a 
close parenthesis, to the expression. 

 

12. When the logic element expression is complete, click Check to verify that the logic 
element is valid. Correct or complete the logic element as needed, checking again to 
verify any changes. 

13. Click OK. Composer adds the logic element to the list in the Application Tree. 

 

To view logic elements:  

• To view a particular logic element expression, with the ALF open in Composer, 
expand the node and right-click the logic element name in the 
Application tree. Select View Logic Element from the right-click menu. 
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• To view a list of all logic element expressions, with the ALF open in Composer, 
right-click the  node in the Application Tree and select Logic 
Elements List from the right-click menu. Composer displays the Logic Elements 
List. 

 

To edit a logic element expression:  

1. With the ALF open in Composer, expand the node and right-click 
the logic element name in the Application tree. 

2. Select Edit Logic Element from the right-click menu. Composer displays the 
Modify Logic Element dialog. 

 

3. Type your edits or use the Create drop-down menu. See “Creating a Logic Element” 
on Page 55 for details. 

4. Click Check to verify that the edited expression is valid. 
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5. Click OK. 

To delete an unused logic element:  

1. With the ALF open in Composer, right-click the  node and select 
Logic Elements List from the right-click menu. Composer displays the Logic 
Elements List. 

2. Select the unused logic element and click Delete. 

3. Click Close. 

Creating an ALF Switch Condition 

You can create a data-driven condition that instructs e-Billing Manager to compose and 
present a customer’s statement using an entirely different ALF.  

An ALF switch condition gives you the greatest level of conditional control over what 
you present to a customer. Using the same DDF, you can create a completely different-
looking statement and present an alternate set of data for targeted customers. For 
example, you could create a condition to specify switching ALFs for larger customers 
whose data requires different table or charting formats.  

Before creating a switch ALF condition, you must determine whether it makes more 
sense to use entirely separate views or to create a condition on a view. 

Each ALF switch condition requires one or more logic elements. A logic element is an 
expression that compares the values in two data fields or between a data field and a 
specific value. You can create logic elements while defining a condition or create logic 
elements first, making them available to select from a drop-down list when creating the 
condition. See “Creating a Logic Element” on Page 55 for details. 

To create an ALF switch condition: 

1. Right-click the node in the Application Tree and select Add ALF from the 

right-click menu, or click the Switch ALF  icon in the ALF toolbar. The Add 
Switch ALF dialog appears. 
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2. Use the options on this dialog to “build” a conditional statement in the Build 
Condition field. (You can manually enter the text in the Build Condition field, but 
choosing from the menus reduces typing and syntax errors.) 

3. Click Condition   If this is the first ALF switch you’re creating, 
select IF from the drop-down list. If you’ve already added one or more ALF switch 
conditions, select ELSE IF.  

4. Under Select Logic Element, click Create to create a logic element for the ALF 
switch; see “Creating a Logic Element” on Page 55 for details. If you have already 
created the logic element, choose it from the Name drop-down list and click Add to 
add it to the condition.  

5. Click Operators to select any operators your conditional statement requires 

. 

6. Add any additional logic elements the condition requires. 
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7. Click Condition again and select the right parenthesis from the drop-down list. One 
set of parenthesis must enclose all logic elements in a condition. 

8. Click Condition and select THEN.  

9. Click Browse to select the ALF (content) to switch to. 

10. Type a name for the switch ALF content in the Name field and click Add to add it to 
the condition. 

11. When the switch ALF condition is complete, click Check to verify that it is valid. 
Correct or complete the statement as necessary, checking the condition again. 

12. When the condition is complete and valid, click Add to List. Composer displays 
the condition in the Condition List at the bottom of the dialog.  

 

13. Click OK. The added switch condition appears in the Application Tree: 
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To view properties of all ALF switch conditions:  

1. With the ALF open in Composer, right-click  below the node 
in the Application Tree.  

2. Choose View Properties from the right-click menu. Composer displays the 
Switch Condition dialog showing all ALF switch conditions defined. 

3. Click OK. 

To edit an ALF switch condition:  

1. With the ALF open in Composer, right click the  node in the Application 
Tree. 

2. Select Modify Condition from the right-click menu. Composer displays the 
Modify Switch ALF dialog.  

3. Double-click the condition from the Condition List and edit it as necessary. 

To change the ALF used in a switch condition only:  

1. With the ALF open in Composer, right click the content name of the ALF listed 
under  Condition below the  node in the Application Tree.  

2. Select Change from the right-click menu. 

3. Composer asks if you are sure you want to change the ALF. Click Yes. 

4. Choose a new ALF from the Change ALF dialog and click OK. 

To delete an ALF switch condition:  

1. With the original ALF open in Composer, right click the content name of the ALF 
listed under  Condition below the  node in the Application Tree. 

2. Select Delete from the right-click menu. 

Adding Conditional Templates 

You can create a condition that instructs e-billing Manager to compose a statement or 
document using an alternate template (not the default template) under specific data-
driven circumstances. This lets you customize the presentation of statements based on the 
data they contain. 

Each condition requires one or more logic elements. A logic element is an expression that 
compares the values in two data fields or between a data field and a specific value. You 
can create logic elements while defining a condition or create logic elements first, making 
them available to select from a drop-down list when creating the condition. See Creating 
a Logic Element on Page 55 for details. 
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To add a conditional HTML template: 

1. With the ALF open in Composer, right-click the node in the Application 

Tree and select Add Template from the right-click menu, or click . Composer 
displays the Add Conditional Template dialog.  

  

2. Use the options on this dialog to “build” a conditional statement in the Build 
Condition field. (You can manually enter the text in the Build Condition field, but 
choosing from the menus reduces typing and syntax errors.) 

3. Click Condition:   If this is the first alternate template you’re 
adding to the ALF, select IF from the drop-down list. If you’ve already added any 
additional templates, select ELSE IF.  

4. Under Select Logic Element, click Create to create a logic element for the template 
condition; see “Creating a Logic Element” on Page 55 for details. Click Add to add it 
to the condition.  
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5. Click Operators to select any operators your conditional statement requires 

. 

6. Add any additional logic elements the statement requires. 

7. Click Condition again and select the right parenthesis from the drop-down list. One 
set of parenthesis must enclose all logic elements in a condition. 

8. Click Condition and select THEN from the drop-down list. 

9. Click Browse to select the alternate HTML template file (content). 

10. Type a name for the alternate HTML template in the Name field and click Add to add 
it to the condition. Names must not contain spaces or special characters, and must 
start with an alpha character. The names must not exceed 30 characters in length. 

11. When the condition is complete, click Check to verify that it is valid. Correct or 
complete the statement as necessary, checking the condition again. 

12. When the condition is complete and valid, click Add to List. Composer displays 
the condition in the Condition List at the bottom of the dialog. 
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13. Add any additional conditional templates, if necessary. 

14. Click OK. Composer adds an node listing the template conditions (along 
with the default template) for the ALF: 

 

To view properties of all template conditions:  

1. With the ALF open in Composer, expand the  node in the Application Tree 
and right-click . 

2. Choose View Properties from the right-click menu. Composer displays the 
Template Condition dialog showing all template conditions defined. 

3. Click OK. 

To edit a template condition:  

1. With the ALF open in Composer, right-click the  node. 

2. Select Modify Condition from the right-click menu. Composer displays the 
Modify Conditional Template dialog. 

3. In the Condition List, double-click the condition you want to change and edit as 
necessary. 

To change the default template file or the template specified as a 
conditional alternate:  

You can change the HTML template file you want to use as the default for a view. You 
can also change the template file specified in a condition as an alternate template. 

1. With the ALF open in Composer, right-click the content name of the template in the 
Application Tree. 

2. Select Change from the right-click menu. Composer displays the following 
message: 

 

3. Click Yes. Composer displays the Change Template File dialog. 
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4. Choose the new template you want to use. If you added sections and groups to the old 
template in the ALF, Composer displays the following warning: 

  

5. Click Yes. Composer removes all the sections and groups defined on that template 
from the ALF. 

To delete a conditional template from an ALF:  

1. With the ALF open in Composer, right-click the template you want to delete.  

2. Select Delete from the right-click menu. Composer asks if you are sure you want to 
delete the template. 

3. Click Yes to delete the template. Composer removes the template from the 
Application Tree. 

Creating a Condition on a Statement Section 

You can create a data-driven condition on a selected area of a statement that instructs e-
Billing Manager to replace the section with a different image, HTML file, text content, or 
NULL when composing the statement. This lets you tailor advertisements or marketing 
messages based on the data in a customer’s statement. 

You can define a condition on any section of a template, such as a block of text, or an 
inserted field, or image.  

Each condition requires one or more logic elements. A logic element is an expression that 
compares the values in two data fields or between a data field and a specific value. You 
can create logic elements while defining a condition or create logic elements first, making 
them available to select from a drop-down list when creating the condition. See “Creating 
a Logic Element” on Page 55 for details. 

You must identify each image, block of text, and HTML file you plan to use in a 
conditional statement as content in Composer. You must name each item you want to 
conditionally insert in the template. The content name acts as a pointer to the image, text, 
or HTML file. You can create content while building a condition on a section or create 
content independently; see “Creating Content” on Page 79. 

You can create compound conditions on a section (IF THEN…ELSE IF) and add 
additional conditions at any time. To create a compound condition on a section, you must 
build, check, and add the first part of the expression and the ELSE IF portion separately. 
For example, to create the compound statement: 
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IF (StateFL) THEN OrangeJuiceAd ELSE IF (StateGA) THEN 
PecanPieAd  

you must build and check “IF (StateFL) THEN OrangeJuiceAd” and add it to the 
conditions list. Then you can build, check, and add “ELSE IF (StateGA) THEN 
PecanPieAd” to the list of conditions for the section.  

To create a condition on a statement section: 

1. With the ALF open in Composer, select the section (text, image, etc.) on which you 
want to create a condition. 

2. With the section highlighted, right-click and select Add Section from the right-
click menu. The Create Section dialog appears: 
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3. Enter a name for the section. Names cannot contain spaces or special characters, and 
must start with an alpha character. Maximum length is 30 characters. Use meaningful 
names; “BigSpenderInsertAirlineOffer” is more descriptive and easier to identify 
than “ALFsection1”. 

4. Use the options on this dialog to build a conditional statement in the Build 
Condition field. You can manually enter the text in the Build Condition field, but 
choosing from the menus reduces typing and syntax errors. (You can optionally 
choose a previously saved condition from the drop-down list if you’ve already 
created a condition you want to reuse in this section. If so, skip to Step 13.) 

5. Click Condition  and select IF from the drop-down list. 

6. Under Select Logic Element, click Create to create a logic element for the 
condition; see “Creating a Logic Element” on Page 55 for details. If you have already 
created the logic element, choose it from the Name drop-down list and click Add to 
add it to the condition.  

7. Click Operators to select any operators your conditional statement requires 

. 

8. Add any additional logic elements the conditional statement requires. 

9. Click Condition again and select the right parenthesis from the drop-down list. One 
set of parenthesis must enclose all logic elements in a condition. 

10. Click Condition and select THEN. 

11. Choose the content to insert from the Name drop-down list under Select Content, or 
click Create to create new content. See “Creating Content” on Page 79 for details.  

12. Click Add to insert the content name in the condition. 
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13. When the section condition is complete, click Check to verify it is valid. Correct or 
complete the statement as necessary, checking the condition again. 

14. If you want the conditions on this section to be available in Marketing Manager, click 
the eaMarket enabled checkbox. 

15. When the condition is complete and valid, click Add to List. Composer displays 
the condition in the Condition List at the bottom of the dialog.  

16. If you want to save the condition for possible reuse in another section, click the 
condition in the Condition List and type a name for the condition in the Condition 
Name drop-down box (next to the Add to List button). Click Save.  

17. If necessary, build any additional conditions to create a compound condition on the 
section. Begin subsequent conditions with ELSE IF. 
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18. Click OK. The condition appears in the  node for the template. (If you 
chose the eaMarket enabled option for the section, it appears with the Marketing 
Manager section  icon instead.) 

 

Creating a Condition to Color Alternate Group Occurrences 

You can configure alternate group occurrence coloring through the Composer (and 
related web composition functionality support) for enhanced control over data 
presentation. 

You can specify a color to apply to alternating group occurrences (or other basis, 
according to the condition you specify) and optionally, a color for the group template 
background. 

To define alternate group occurrence coloring: 

1. Open the application in the Composer, then open the group template in the HTML 
view. 

2. Add an HTML tag that can specify a background color attribute for the template, 
such as <TBODY STYLE=”background-color:red”>. The tag can be a 
<P>, <DIV>, <TABLE>,<TBODY> etc. 

3. Select the entire tag, including the angled brackets < >. Right-click and select the 
Add Section… menu option. The Create Section dialog appears (with fields empty). 
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4. Specify a section name. 

5. Click the Create button in the Select Logic Element section. The Create Logic 
Element dialog appears. The logic element you create here becomes part of the 
condition you’re building. Specify an expression consisting of an INDEX() function. 
Specify a path related to the group inside the function (or leave it blank to use the 
current path or specify a relative path such as (//G3[])). For example, to color 
alternate occurrences of the group G4.G3, beginning on the first occurrence, specify 
INDEX(/G4[]/G3[])%2== 1. You can select data type, fields, and operators from the 
drop-down menus.  (Specify == 0 if you prefer to begin color on the second 
occurrence. To color every third group occurrence or some other basis, specify %3, 
etc, and == 1 to begin color on the first occurrence, == 2 for the second occurrence, 
or == 0 for the third, based on the remainder when dividing the group occurrence by 
the basis.) Click OK. 
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6. On the Create Section screen, click the Create button in the Select Content section.  
The Create Content dialog appears. The content you create here becomes part of the 
condition you’re building. Specify a name for the content. Select Insert Text as 
the type. In the Insert Text box, edit the background color and add the color you want 
to use for the condition (alternating group, etc.) You can use either the English name 
(red, yellow, etc.) or the RGB color (#FFFF00, etc.) If no attribute for background 
color was specified in the group template tag (if it has just <DIV>, for example, add 
an attribute here but specify the color for alternating groups. Click OK.  
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7. Build the condition using the logic element and the content. When the condition is 
complete and valid, click Add to List. Composer displays the condition in the 
Condition List at the bottom of the dialog. Click OK and save the ALF file. 

8. Composer adds an edocsSECTION tag with the alternate group coloring information 
enclosing the original HTML tag, as in: 
<eDocsSECTION=SEC1><TBODY style=”BACKGROUND-COLOR: 
RED”></eDocsSECTION=SEC1> 

This section appears in the Application tree view under the group where the section 
was applied.  

Supported Index Expressions 

The following examples of the INDEX expression usage assume a group structure of 
root/G4/G3, where G3 is the current template:  

 

Index Expression Change Occuring in G3 

INDEX() Color the current group template 

INDEX(//G3[]) Color the group template in the relative path 
specified 

INDEX(/G4[ ]/G3[ ])%2==1 Color any odd numbered G3 occurrences, 
within any G4 

INDEX(/G4[1]/G3[ ])%2==1 Color any odd numbered G3 occurrences, 
within the first occurrence of G4 

INDEX(/G4[ ]/G3[ ])==1 Color the first G3 occurrence, within any G4 

INDEX(/G4[1]/G3[ ])==1 Color the first G3 occurrence, within the first 
G4 occurrence 

 

Caution
 

Using * and ? are meaningless in INDEX(), but not yet restricted through 
the UI. Do not use these characters. 

Deleting, Modifying, and Viewing Conditions 

To display a list of saved conditions:  

• Click the Show Conditions icon  on the ALF toolbar. (Note table conditions are 
not included.) 
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To view the properties of a condition:  

1. With the ALF open in Composer, double-click the node (below the 
node). Composer displays the conditions (sections) defined in this template. 

2. Double-click the name of the condition (section) you want to view. 

3. Right-click on the  node and select View Properties from the right-
click menu. Composer displays the Section Condition dialog with the conditional 
statement. 

 

To modify a condition on a section:  

You can modify a condition on a section or add one or more ELSE IF conditions to a 
section (creating compound conditions). 

1. With the ALF open in Composer, double-click the node (below the 
node).  

2. Right-click the name of the condition you want to modify. 
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3. Select Modify Section from the right-click menu. The Modify Section dialog 
appears.  

4. To modify an existing condition, double-click on the condition and edit as needed. To 
add a new condition to the section, follow the procedures above to add an ELSE IF 
condition. 

To delete a condition on a section:  

1. With the ALF open in Composer, double-click the node (below the 
node).  

2. Right-click the name of the condition you want to delete. 

3. Select Delete Section from the right-click menu. 

4. Composer asks if you’re sure you want to delete the section. Click Yes. 

Creating Content 
Content is any image, “block” of text, or HTML that you conditionally insert in a section 
of a statement based on the user’s data. You must identify each item you plan to use in a 
data-driven condition as content, and give each a name. The content name acts as a 
pointer to the image, text, etc.  

You must define each of the following items as content to use them in a condition: 

• Images 

• Blocks of text 

• HTML files 

• Alternate (switch) ALFs  

• Alternate HTML template files 

By naming content, it becomes available to select from a drop-down list when building 
conditions on a section. (You can also create new content when building a condition.) 

You must create content to use in table conditions separately; table content is not 
available for use in general (non-table) conditions and vice-versa. Composer ties table 
content directly to the particular table condition, and it can include font and cell 
formatting, unlike non-table content. (You can create some reusable table content for use 
with other table conditions only.) See “Creating Conditions on a Table (Line Item)” on 
Page 89 for information. 
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Creating New Content 

Follow these instructions to create content for use in conditions on non-table sections of a 
statement. (See “Creating Table Content” on Page 93 for information about creating table 
content.) 

To create new (non-table) content: 

1. In the Application Tree, right-click the  node and select Create from the 
right-click menu. The Create Content dialog appears.  

 

2. Click the content type: Select HTML File, Insert Text, or Insert Image. 

3. Enter a unique and meaningful name for the content. Names cannot contain spaces or 
special characters, must start with an alpha character, and cannot exceed 30 
characters in length. 

4. Browse the File Location field to select an HTML or image file, or type the text 
content in the Insert Text box. 



Defining Statement Presentment 

e-Billing Manager Presentation Design Guide  |  81 

 

5. Click OK. The content name appears in the Application Tree:  

Viewing Content 

You can display a list of all contents defined for an ALF showing the content type, 
details, and status (used or unused). You can optionally display a list of table content 
only. 

You can also view the properties of individual contents. 

To view a list of all content and properties: 

1. With the ALF open in Composer, right-click the  node (or click the 

 node for a list of table content only). 

2. Select Content List from the right-click menu. Composer displays the Content 
List dialog. 
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To view properties of individual content: 

1. With the ALF open in Composer, double-click the  node to display a list 
of content names in the Application Tree.  

2. Right-click the content name and click View Properties from the right-click 
menu. Composer displays the View Content dialog (or the View Reusable Content 
dialog for reusable table content). 

 

Changing Content 

You can modify change the HTML template file, text, or image file associated with a 
content name by editing the content properties. (You can also modify table content and 
reusable table content.)  

To edit content properties:  

1. With the ALF open in Composer, double-click the  node to display a list 
of content names in the Application Tree. (Double-click the  node 
to display a list of table content names, if necessary.)  

2. Right-click the content name you want to edit. 
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3. Select Edit Properties from the right-click menu. Composer displays the Modify 
Content dialog (or the Modify Reusable Content dialog for reusable table content). 

4. Edit the content as necessary and click OK. 

Deleting Unused Content 

You can delete any content that is not in use in a condition, including reusable table 
contents. 

To delete unused content: 

1. With the ALF open in Composer, right-click the  node in the Application 
Tree. (Click the  node to view a list of table content only.)  

2. Select Content List from the right-click menu. The Content List dialog appears.  

3. Select the unused content item you want to delete and click Delete. 

4. Click Close. 

Mapping a Notification Link 
You can map a notification link into an HTML email template. e-Billing Manager adds a 
direct link to the production web server, based on the configuration settings in the 
edocsCommand Center. In production, this link is embedded in the delivered email and 
provides the recipient with a convenient and customized link to their login page. 

To map an email notification link into the email template:  

1. With the ALF and email template open in Composer, click the  tab in 
the Application Tree area. 

2. Click the Notification Link icon  and drag and drop the link where you want it to 
appear in the template. (The email notification link appears in the template as 
[E]NotificationLink,L[/E]. The “L” indicates this is a link.) 
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3. If the HTML template uses placeholders, delete them. 

4. Click the Save Template  icon.  

Using Encoded Character Sets in the HTML Templates 
To enable composed HTML pages to properly display the character set defined in the 
DDF, you must add the character set tag to the HTML template.  

(If you want to use the default character set name specified in the code for presentment, 
do not complete the following procedure.) 

To insert an [E] tag with the character-set name in the HTML templates: 

1. On the right side of the Composer screen, click the HTML tab. 

2. Select Insert > Character set. Composer inserts the character set name 
specified in the DDF into the default template and any conditional templates 
associated with the ALF as an [E] tag in the form charset=[E]Character-set[/E], for 
example: 
<META content="text/html; charset=[E]ISO-8859-1[/E]" http-
equiv=Content-Type> 

3. To enable the character set name you specified in the HTML template to override the 
default character set name in the code, your application designer must manually edit 
your Validation.jsp (included in Detail.jsp to support e-Billing Manager user 
validation). They must remove the line shown here in bold:  
 
 <% 
    response.setContentType(“text/html; charset=ISO-8859-1”);     
    validator.validateParameterNames(request); 
    validator.validateParameterValues(request); 
%> 
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Elements 

Mapping Tables and Groups 
To present the groups and tables you defined in the DDF in your statement, you must 
map them to the location in the template where you want them to appear. Composer lets 
you click-and-drag tables and groups to the template. 

You can present tables in one of two formats: 

• As text in an HTML table 

• As a chart that you design when mapping 

A group consists of one or more tables that recur in a visual pattern. The simplest group 
can consist of one table of which there are multiple occurrences. Groups can be used also 
display information that repeats together. Each set of tables in a pattern is a group 
occurrence. 

For details about mapping and formatting tables as charts, see Chapter 5. 

Mapping a Table as Text 

To map a table as text in a statement template: 

1. With the ALF open in Composer, add an HTML table to the statement HTML 
template (if you haven’t already); select Table>Insert Menu. 

2. Click the  tab in Tree area and expand the list of DDF tables by clicking 
on the + sign next to “Tables.” 

3. Drag and drop the table you want to map to the location in the HTML table where 
you want it to appear.  
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4. Select Text and click OK. “[E]TableName, R[/E]” appears in the template. 

5. If your HTML template used placeholders, delete them. 

6. Click  to save the template. 
 

Tip
 

If you delete a field, table, or group from the DDF, you must manually 
delete the associated tag from the HTML template. 

Mapping a Group 

To map a group to a statement template, you drag-and-drop the group to the template, 
identify the group template to use for display, and specify the condition for using this 
template (every occurrence or some other basis). 

Because you specify an external group template for presenting the group, you don’t need 
to create an HTML table for the group; you don’t need to encapsulate the group with any 
HTML tags. The HTML group template contains the [E] tags for the group’s 
components, and the ALF contains the formatting rules for all tables and groups. 

 

Correct Incorrect 
[E]Group,G[/E] <table width=”100%”> <tr> <td> 

[E]Group,G[/E]</tr> </td> </table> 

<table width=”100%”> 
[E]Table,R[/E] 
</table> 

[E]Table,R[/E] 

To map a group to a statement template:  

1. Click the  tab in the Tree area and double-click the  node 
to expand the list of groups defined in the DDF. 

2. Drag-and-drop the group you want to map to the HTML template. The Group dialog 
appears.  
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3. Select the “condition” for inserting the group template; in most cases you want to 
specify Every and 1 to insert the group template for each occurrence. (Specify a 
different frequency and number of times to insert the group template if required.) 

4. Specify the group template or click Browse and select a template. 

5. Click OK. The group HTML appears with a blue “content” icon in the Application 
Tree under the template where you mapped the group: 

 

6. Click  to save the ALF. 

Modifying the Group Template 

You can change the group HTML template used to display a group in the statement or 
modify the “condition,” or frequency to apply the group template.  

To modify the group template or condition: 

1. With the ALF open in Composer, expand the  groups icons in the Application 
Tree to display the group you want to modify.  

2. Right-click the  icon for the group and select Modify from the right-click menu. 
Composer displays the Group dialog. 

3. Make the necessary modifications. 

4. Click OK. 
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Deleting a Group 

To delete a group from a statement you should delete both the group tag and the group 
HTML association.  

To delete a group from a statement: 

1. With the ALF open in Composer, select the group tag in the statement and delete it. 

2. In the Application Tree, right-click the group name and select Delete from the 
right-click menu. Composer asks if you’re sure you want to delete the group. 

3. Click Yes. 

Formatting Tables 
You can apply various formatting to enhance the appearance and readability of tables and 
to customize customer content.  

You can apply formatting or add content to: 

• An entire table – Use the Composer Format menu or Formatting toolbar to apply 
font and paragraph formatting such as styles, bolding, indentations, alignment, etc. T 
e-Billing Manager applies the formats to all columns and rows in the table. You 
apply table-wide formatting in the HTML template. 

• Individual columns – In the temporary HTML displayed for configuring a table, use 
the Format menu or the Formatting toolbar to apply formatting to columns. 

• Customer-specific rows based on their data (using conditions) – In the temporary 
HTML displayed for configuring a table, you create a section and specify the data-
driven condition that (a column of) the customer’s data must meet for e-Billing 
Manager to apply the formatting or content. Conditional table formatting is useful, 
for example, to highlight a row containing a negative amount in red, add an 
advertising image, text, or link in a cell, or to remove a link to a detail drill-down 
view if a data amount equals zero. 

• A patterns of rows – In the temporary HTML displayed for configuring a table, you 
create a section and define a pattern of lines and the table formatting (or other 
content, if useful) you want to apply to the pattern. For example, after every third row 
you could highlight two rows in blue for readability.  
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Formatting an Entire Table 

To apply formatting to an entire table: 

1. With the ALF open in Composer, select the table and use the Format menu or the 
Formatting toolbar to choose formatting. (If a table is part of a group, first click the 
group name shown under the  node in the Application Tree to list the 
tables in the group.) 

2. Click  to save the formatting to the template (or wait and save the entire ALF at 
the end of your editing session, if you prefer). 

Formatting Individual Columns 

To format table columns: 

1. With the ALF open in Composer, select the table you want to edit. Be sure to select 
the start and ending E tags with the table name. (If a table is part of a group, first 
click the group name shown under the  node in the Application Tree to 
list the tables in the group.) 

2. Right click on the selection, and select Configure Table from the right-click 
menu. A new window opens with a temporary HTML page.  

3. Select individual columns to format in either WYSIWYG or HTML mode.  In 
WYSIWYG mode, use the Format menu or the Formatting toolbar to add formatting. 
In HTML mode, you can enter HTML formatting code directly. (You must add all 
structural formatting, such as modifications to td width, height, or vAlign in HTML 
mode. 

4. Click  to save the ALF. 

Creating Conditions on a Table (Line Item) 
Conditions on a table let you tailor advertising or marketing messages based on the data 
in the individual lines of a customer’s statement, or format the line based on a key data 
value.  

You can create data-driven conditions on a table or selected columns instructing e-Billing 
Manager when to apply table content to that selection. e-Billing Manager checks the 
condition for each line of data and, if true, applies the content to that line only. Table 
content can include any combination of font and cell formatting (color, bold, italics, 
alignment, etc.), or an image, text, or hyperlink that e-Billing Manager adds to the section 
when composing the statement. You can optionally specify different content for each 
column in a condition. The data driving a table condition must be within the same table. 
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For example, you could create a condition on a table to: 

• Highlight a row containing a negative amount in red (content can include or be 
limited to font or cell formatting). 

• Add a targeted advertising image to a line item in a credit card statement based on the 
nature of the purchasing data, such as the name of the clothing retailer, type of 
clothing purchased, or the purchase amount. (You can optionally replace the section 
with an image using reusable table content in the condition.) 

• Add a hyperlink, such as one offering a discount purchase coupon for the linked retail 
Web site. 

• Remove a link to a detail drill-down view if a data amount equals zero 

• Add a text message with targeted offers or information to the customer based on the 
transaction. (You can optionally replace the section with text using reusable table 
content in the condition.) 

• Replace the section with a null. (You must use reusable table content in the condition 
to replace a section with a null.) 

• Suppress section display. (You must use reusable table content in the condition to 
suppress display.) 

When creating a condition on a table, you must define the content specifically for that 
condition, called “table content.” You cannot use content created for non-table sections in 
a table condition and vice-versa. You can, however, create reusable table content and 
apply it to multiple conditions. You must create and apply reusable table content in the 
condition if you want to insert a null or suppress section display; regular table content 
cannot do this. Also, if you want to replace a section with an image or text instead of 
adding it before or after existing section content, you must create and apply it as reusable 
table content in the condition. See “Creating Table Content” on Page 93 for details. 

Each condition on a table requires one or more logic elements. A logic element is an 
expression that, in a table condition, can compare: 

• The values in two columns 

• The value in a table column to a specific value such as a date, time, amount, NULL 
or EMPTY, or a regular expression 

• A table or group with NULL or EMPTY (to test for existence) 

You can create logic elements while defining a condition or create logic elements first, 
making them available to select from a drop-down list when creating the condition. See 
“Creating Conditions” on Page 54 for details on condition syntax and creating logic 
elements. 

To create a condition on a table: 

1. With the ALF open in Composer, select the table on which you want to create a 
condition. (If a table is part of a group, first click the group name shown under the 

 node in the Application Tree to expose the tables in the group.) 

2. Right click and select Configure Table from the right-click menu.  
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3. Select the section you want the condition to apply to (one or more, or all columns), 
then right-click and select Add Section and Conditional Table Format from 
the right-click menu. The Create Section dialog appears. 

 

4. Enter a name for the section. Names cannot contain spaces or special characters, and 
must start with an alpha character. Maximum length is 30 characters. Use meaningful 
names; “BigSpenderInsertAirlineOffer” is more descriptive and easier to identify 
than “ALFsection1”. 

5. Use the options on this dialog to build a conditional statement in the Build 
Condition field. You can manually enter the text in the Build Condition field, but 
choosing from the menus reduces typing and syntax errors. (You can optionally 
choose a previously saved condition from the drop-down list if you’ve already 
created a condition you want to reuse in this section. If so, skip to Step 13.) 
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6. Click Condition  and select IF from the drop-down list. 

7. Under Select Logic Element, click Create to create a logic element for the 
condition; see “Creating a Logic Element” on Page 55 for details. If you have already 
created the logic element, choose it from the Name drop-down list and click Add to 
add it to the condition.  

8. Click Operators to select any operators your conditional statement requires 

. 

9. Add any additional logic elements the conditional statement requires. 

10. Click Condition again and select the right parenthesis from the drop-down list. One 
set of parenthesis must enclose all logic elements in a condition. 

11. Click Condition and select THEN. 

12. Do one of the following: 

• To create content for this table, click Create. (See the instructions for creating 
table content in “Creating Table Content” on Page 93.) 

• To use an existing reusable table content, select it from the Name drop-down list 
under Select Content. 

• To create new, reusable table content, click Reusable. (See the instructions for 
creating reusable table content in “Creating Table Content” on Page 93.) 

13. Click Add to insert the content name in the condition. 

14. When the condition is complete, click Check to verify it is valid. Correct or complete 
the statement as necessary, checking the condition again. 

15. If you want this condition to be available in Marketing Manager, click the eaMarket 
enabled checkbox. (If you choose this option for a section, it appears with the 
Marketing Manager section  icon.) 

16. When the condition is complete and valid, click Add to List. Composer displays 
the condition in the Condition List at the bottom of the dialog.  

17. If you want to save the condition for possible reuse in another section, click the 
condition in the Condition List and type a name in the Condition Name drop-down 
box (next to the Add to List button). Click Save.  

18. If necessary, build any additional conditions to create a compound condition on the 
section. Begin subsequent conditions with ELSE IF. 
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19. Click OK. The condition appears in the  node for the template. Composer 
also adds a number to the table tag in the template, as in [E]LineCallList_0,R[/E], 
indicating a condition is defined on the table. 

Creating Table Content 

When creating a condition on a table, you must define new table content for use with the 
condition. You cannot use content created for non-table sections of a template in a table 
condition. In addition, the table content you create does not automatically become 
available for use in other table conditions. Composer ties table content directly to a 
particular table condition. You can create reusable table content, however, to define 
certain types of content, and these are available for reuse in other table conditions. 

Table content can specify: 

• Font formatting - Bolding, italics, underlining, and text color.  

• Cell formatting – Alignment (left, right, center) and cell background color.  

• Text and an optional hyperlink on the text.  

• An image and an optional hyperlink on the image.  

• Hyperlinks 

In addition, you can specify different content and format for individual columns in the 
condition (and these specifications are kept together as table content for the condition). 

You must use reusable table content to: 

• Suppress display 

• Insert a null 

• Replace a section with text (use regular table content to add text)  

• Replace a section with an image (use regular table content to add an image) 

To create table content: 

1. You create table content by clicking the Content button on the Create Section dialog 
when creating a condition on a line item or on a pattern of rows. (e-Billing Manager 
displays the Create Content dialog.) You cannot create table content independently of 
a table condition, except to create reusable content (see below). On the Create 
Content dialog, enter a name for the content in the Content Name field. 
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2. If you want the table content you specify to apply to all columns selected for the 
condition, click the Apply to All option. If you want to apply different content to 
individual columns, select the column names one at a time and proceed to specify the 
content. 

3. Specify content use the tab options and/or the formatting toolbar(you can optionally 
click the HTML tab to edit the HTML directly): 

• Font formatting – For bold, italics, underlining, and font color, use the Font tab 

and/or the  toolbar buttons. 

• Cell formatting – To align left, center, or right, and apply background color to 

cells, use the Cell tab and/or the  toolbar buttons. 

• Text – Use the Text tab to define a block of text to add and optionally specify a 
hyperlink to use on the text. You must specify whether you want e-Billing 
Manager to insert the text before or after the existing section content; select 
either the Prefix or Suffix option on the Text tab. 

• Image – Use the Image tab to specify the path of an image file to insert and 
optionally specify a hyperlink to use on the image. You must specify whether 
you want e-Billing Manager to insert the image before or after the existing 
section content; select either the Prefix or Suffix option on the Image tab. 
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• Hyperlink – Use the Hyperlink tab to specify an address to add as a link.  

4. If you specify content in the Text, Image, or Hyperlink tabs, click Apply on that tab. 

5. Use the Reset button if you want to clear any formatting you’ve selected. 

6. Click OK. The name of the table content appears with a blue icon under the Table 
Content node in the Application Tree. 

 

To create reusable table content: 

You can create reusable table content while creating a condition on a table or at any time. 

1. If you clicked the Reusable button on the Create Section dialog when creating a 
condition on a table (including on a pattern of rows), e-Billing Manager displayed the 
Create Reusable Content dialog.  

If not, with the ALF open in Composer, right-click the  node in the 
Application Tree and select Create Reusable. Composer displays the Create 
Reusable Content dialog. 

 

2. Specify a name for the reusable content. 

3. Click the type of content you want to define: Suppress (to suppress display), Insert 
Null, Replace Text, or Replace Image. 

4. For a null, text, or image, specify the number of cells.  
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5. To add a hyperlink to text or an image, click the Hyperlink option and specify a 
link.  

6. Click OK. The name of the reusable content appears with a yellow icon under the 
Table Content node in the Application Tree: 

 

To view a list of table and reusable content: 

• See “Viewing Content” on Page 81. 

To change table content: 

• See “Changing Content” on Page 82. 

To delete (unused) reusable table content: 

• See “Deleting Unused Content” on Page 83. 

Deleting, Changing, or Viewing Table Conditions 

To view the properties of a table condition: 

1. With the ALF open in Composer, double-click the node (below the 
node). Composer displays the list of conditions (sections). 

2. Double-click the name of the condition (section) you want to view. 

3. Right-click on the  node and select View Properties from the right-
click menu. Composer displays the Section Condition dialog with the conditional 
statement. 

 

4. Click OK. 
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To modify a condition on a table: 

You can modify a table condition or add one or more ELSE IF conditions to a section 
(creating compound conditions). You can also modify the condition on a pattern of rows. 

1. With the ALF open in Composer, double-click the node (below the 
node) for the table.  

2. Right-click the name of the condition you want to modify. 

3. Select Modify Section from the right-click menu. The Modify Section dialog 
appears.  

4. For a regular table condition, double-click on the condition and edit as needed. To 
add a new condition to the table section, follow the procedures above to add an ELSE 
IF condition. For a condition on a pattern of rows, edit the condition as needed. 

5. Click OK. 

To delete a table condition: 

1. With the ALF open in Composer, double-click the node (below the 
node) for the table.  

2. Right-click the name of the condition you want to delete. 

3. Select Delete Section from the right-click menu. 

4. Composer asks if you’re sure you want to delete the section. Click Yes. Composer 
updates the table tag on the template (removes “_0,” for example). 

Applying Formatting or Adding Content to a Pattern of 
Rows 

You can apply table content to a defined pattern of rows, letting you apply color highlight 
to alternating rows in a statement, for example. Color or other formatting can often make 
the lines of a statement easier to read.   

You can apply the same types of table formatting and content to a row pattern as you can 
to regular table conditions on a line item. The “condition” in this case is simply the 
pattern of rows you define, and is not based on extracted data. For details on the types of 
formatting and content you can add to a pattern of rows, see “Creating Table Content” on 
Page 93.  

You specify a pattern by the starting row number and the number of rows to repeat. For 
example, if you specify the row number to start at as 3 to repeat for 2 rows, and define 
the content as font color highlighting in yellow, then e-Billing Manager composes every 
other two rows in yellow: 
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Row 1: Default color 
Row 2: Default color 
Row 3: Yellow 
Row 4: Yellow 
Row 5: Default color 
Row 6: Default color 
 

To apply a somewhat more complex highlighting, you can define multiple patterns for a 
table. For example, you would need to create two separate sections to achieve the 
following color highlight pattern: 

Row 1: Yellow 
Row 2: Green 
Row 3: Blue 
Row 4: Yellow 
Row 5: Green 
Row 6: Blue 
 

In this example, you apply yellow as the default table color in the default template. Then 
you would create one section on the table with a pattern that starts on row 2 and repeats 
for 1 row in green, and another section on the table with a pattern that starts on row 3 and 
repeats for 1 row in blue.  

To format a pattern of rows in a table: 

1. With the ALF open in Composer, select the table you want to edit. (If a table is part 
of a group, first click the group name shown under the  node in the 
Application Tree to expose the tables in the group.) 

2. Right click on the selection, and select Configure Table from the right-click 
menu. A new window opens with a temporary HTML page.  

3. Select the table you want to format, and right click to select Format Table from the 
right-click menu. The Create Section dialog appears.  
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4. Enter a name for the section, such as HighlightEveryOtherRow. 

5. Do one of the following: 

• To create content for this table, click Create. (See the instructions for creating 
table content in “Creating Table Content” on Page 93.) 

• To use an existing reusable table content, select it from the Name drop-down list 
under Select Content. 

• To create new, reusable table content, click Reusable. (See the instructions for 
creating reusable table content in “Creating Table Content.” 

6. Specify the row number where you want the pattern to begin.  

7. Specify the number of rows you want to apply the table content to. 

8. Click OK. The condition appears in the  node for the template. Composer 
also adds a number to the table tag in the template, as in [E]LineCallList_0,R[/E], 
indicating a condition is defined on the table. 

To delete, modify, or view a condition on a pattern of rows: 

• See “Deleting, Changing, or Viewing Table Conditions” on Page 96. 
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Sorting Tables and Groups 
You can enable Web users to sort the data in their statements by creating sort elements 
and adding a link to the element in an appropriate place in the statement. You can sort on 
a table or a group. 

You can create multiple sort elements within a statement ALF; you can also use the same 
link for multiple sort (or filter) elements. 

The Simulator lets you validate the format of sort elements; see “Simulating Sorting and 
Filtering Elements” on Page 136. 

Table Sorting 

You can enable Web users to sort rows in a table in ascending or descending order by the 
values in a particular column. To do this, you create a sort element in table mode 
identifying the table and column to sort on, specify whether to sort in ascending or 
descending order, then create a sort element link and add it to the template.  

When a Web user clicks a sort element link, the statement page redisplays with the table 
rows reordered according to the specifications of the sort element. When the user clicks 
the sort element again, sorting order automatically reverses. 

Example - View of unsorted table (rows of a credit card statement ordered 
by Posting Date): 

 

Posting 
Date 

Transaction 
Date 

Reference 
Number 

Transactions Charges

5/20 5/19 10384 Illuminations Lighting 166.79 

5/23 5/22 10298 Springfield Getty 18.50 

5/25 5/24 10273 American Airlines 1680.00 

5/30 5/29 00578 Ocean Grill 65.00 

6/06 6/04 20182 Harbor Line Cruises 126.06 

Above table sorted by “Charge” column: 
 

Posting 
Date 

Transaction 
Date 

Reference 
Number 

Transactions Charges

5/23 5/22 10298 Springfield Getty 18.50 

5/30 5/29 00578 Ocean Grill 65.00 

6/06 6/04 20182 Harbor Line Cruises 126.06 

5/20 5/19 10384 Illuminations Lighting 166.79 

5/25 5/24 10273 American Airlines 1680.00 
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If a table is part of a group, e-Billing Manager sorts within each occurrence of the table. 
To enable sorting across occurrences of a table or group, create a combine element on the 
table or group in addition to the sort element. Creating both a sort and combine element 
on a table or group sorts and displays the rows from all table or group occurrences in 
sequence according to the sort column value. To create a combine element, see “Using 
Combine Elements to Page, Sort, & Filter Across Table or Group Occurrences” on Page 
127. 

Group Sorting 

You can enable Web users to sort occurrences of group data in ascending or descending 
order. To sort a group, you create a sort element in group mode identifying the table and 
column (or the group field), specify whether to sort in ascending or descending order, 
then create a sort element link and add it to the template. When a Web user clicks the 
link, the statement page redisplays with the group occurrences reordered according to the 
specifications of the sort element. When the user clicks the link again, sorting order 
automatically reverses. 

e-Billing Manager sorts group occurrences according to the sort column value in the first 
row of the first occurrence of the table in the group. The first occurrence of the table on 
which you define the sort element acts as the “lead table,” and the first row of this table 
occurrence as a “lead line” for sorting the group.  

This can be useful, for example, when the tables in a group contain only one row, such as 
the lines of an address, or wherever it makes sense to sort on just one column and the first 
row of a table. 

Example - View of unsorted group (tables of calling card line item data): 
 

     Duration Charge 

G1(0) T1(0)  10/21/02 12:35 pm 0:24:18 10.00 

 T2(0)  Rye, NY Atlanta, GA   

       

G1(1) T1(0)  10/22/02 4:08 pm 0:05:46 1.60 

 T2(0)  Atlanta, GA: Chicago, IL   

       

G1(2) T1(0)  10/24/02 6:00 am 1:59:04 34.90 

 T2(0)  Chicago, IL Rye, NY   

Above group sorted by call charge column: 
 

     Duration Charge 

G1(1) T1(0)  10/22/02 4:08 pm 0:05:46 1.60 

 T2(0)  Atlanta, GA: Chicago, IL   
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     Duration Charge 

G1(0) T1(0)  10/21/02 12:35 pm 0:24:18 10.00 

 T2(0)  Rye, NY Atlanta, GA   

       

G1(2) T1(0)  10/24/02 6:00 am 1:59:04 34.90 

 T2(0)  Chicago, IL Rye, NY   

Creating a Sort Element 

To create a sort element: 

1. With the ALF open in Composer, right-click  in the Application Tree. 

2. Select Create Sort Element from the right-click menu. The Configure Sort 
dialog appears.  

 

3. Under Sort Mode, click Table to create a sort on a table, or Group to create a sort on 
the occurrences of a group. 

4. Enter a descriptive name for the sort. The name cannot contain spaces or special 
characters, must start with an alpha character, and cannot exceed 30 characters in 
length. 

5. On the tree of table and groups, expand the list and select the table or group you want 
to sort. 
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6. Double-click the table and column you want to sort by. If sorting a group, you can 
select a group field. If you make a mistake, click Clear and reselect the table and 
column. 

7. Select the data type of the column you’re sorting. 

8. If the data type is date or time, select the appropriate sort format from the Data 
Format drop-down list or type one of your own. Manually enter any separators 
within the data format, if necessary. (You can copy, cut, and paste selected values 
from the list of formats to build the one you want. Right click the format to display 
the Edit menu.) 

9. In the Default Direction field, choose the direction to sort: ascending or descending. 

10. If the data type is currency or decimal, specify a separator (decimal point or comma) 
in the Decimal Separator field.  

11. If the data type is currency, you can optionally select a symbol to represent a negative 
value: -, CR, cr, DB, db, or ().  

12. If the data type is a date or time, click the Validate button  to verify that the 
format you’ve entered complies with the data type. 

13. Click  to create the sort element. 

14. Click  to save the ALF.  

15. Follow the instructions in the next section to create a link to the sort element. 

Creating a Link to a Sort Element 

After creating a sort element, you must create a link users can click to perform the sort. 
You can create a link on static text, an image, or an [E] tag. 

You can optionally choose to add a Reset URL function to the link. By default, the sort 
would be cumulative on any previous URLs the user chose in the session. Adding this 
function enables you to clear any previous URL actions the Web user took, such as 
filtering data, before applying the sort (except if you sort the same table or group using a 
different column from a previous sort, e-Billing Manager removes the previous sort and 
applies the new one). 

To create a link to a sort element: 

1. With the ALF open, select the item you want to use as a link (be sure to completely 
highlight the item). 

2. Right-click and select Create Link from the right-click menu. The Create Link 
dialog appears. 
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3. Click Parameters. The Add Parameters dialog appears. 
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4. If the link is to a sort that appears in a different view, enter the name of the target 
view.  

5. Click the Sort Elements drop-down list and select the sort element you want to 
link. 

6. Click . The sort element appears in the Added Elements area. (You can 
use the Remove and Clear All buttons on items in this list.) 

7. If you want to clear the actions of any previous URLs before displaying this sort, 

click   to add the Reset URL function to the link. 
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8. Click . Composer displays the view name and sort element in the Create 
Link dialog. 
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9. Click  to create the link. Composer adds a blue hyperlink to the 
statement. 

10. Click  to save the template. 

11. If you added a link to a table column, click  to save the ALF. 
 

Tip
 

You can create a sort or filter element from the Add Parameters dialog; 

click . See “Sorting Tables” on Page 100 or “Filtering 
Data” on Page 114 for details. 

Modifying a Sort Element 

To modify a sort element: 

1. With the ALF open in Composer, right-click the sort element and select Modify 
Sort Element from the right-click menu. Composer displays the Configure Sort 
dialog. 

2. Edit the sort element. 

3. Click OK.  
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Deleting a Sort Element 

To delete a sort element: 

1. With the ALF open in Composer, right-click the sort element and select Delete 
Sort Element from the right-click menu. Composer asks if you’re sure you want to 
remove this sort element. 

2. Click Yes. Composer removes the sort element from the ALF. 

3. You must manually remove the link to the sort element in the HTML template.  

Adding a Sort Direction Indicator 

You can add a sort direction indicator to an existing sort element that also has a sort link. 
For example, you can show the character “A” when the sort is ascending and character 
“D” when it is descending; or you can show images or other objects as well. If the 
column is not sorted, no indicator appears. 

To create a sort direction indicator: 

1. Display the template in WSSIWYG view. 

2. Next to the sort element, add an object that you want to appear when the user sorts 
the element in the defined direction. For example, you could type the character “A” , 
“D” or insert an image or other object. 

3. Highlight the object, right-click it, select Sorting…, then Configure Indicator. 

4. The Sort Direction Indicator dialog box appears. Select the name of the sort element 
associated with this indicator and choose the sort direction used for this object. In our 
example, it would be Ascending for “A”:  

 

5. Click OK to save the changes to the template. You can now see the [E] tag describing 
the sort indicator in the WYSIWYG view. The syntax for the sort indicator is: 



Mapping Text Tables and Configuring Elements 

e-Billing Manager Presentation Design Guide  |  109 

[E]SI(“sort_spec_name”, “Asc/Desc”, “selected_object”)[/E] 

So, for this example, the [E] tag would look like: 
[E]SI(“LocDesc”, “Asc”, “A”)[/E] 

6. Save the HTML template to make the changes permanent. 

After indexing and publishing the application, you can see the statement in the browser. 
Initially the sort element will show no indicator because the column is not sorted. If you 
click on the sort link (column heading), the sort indicator will appear (the letter A from 
our example). If you did not define a separate sort indicator for the descending sort 
direction, clicking on the sort link again will show no indicator for the column. 

To delete or modify a sort direction indicator: 

To delete any sort direction indicator you have created, simple remove the SI[E] tag 
from the HTML template in the WYSIWYG view. To modify the sort direction indicator, 
you can delete it and recreate it using the steps described above, or you can edit the 
SI[E] tag text directly. 

Paging Statements 
Creating a page element lets you present large documents in multiple browser pages each 
with a fixed (configurable) number of rows. You can configure paging on a group or a 
table. You can also define page sets to display a fixed (configurable) number of pages in 
each set.  

Using a paging element and page set can speed up the display of statement data to the 
user. Paging uses progressive data extraction so the user does not have to wait for all data 
to extract before starting to view it. 

Once you create a page element and any page sets you must add one or more links to the 
statement for navigating between pages and page sets. 

By default, e-Billing Manager starts a new page for each occurrence of a table or group, 
regardless of how many rows there are. To eliminate the new page start and display table 
or group information contiguously, define a combine element for the table or group. Web 
users can then view the same amount of information in fewer (full) pages. See “Using 
Combine Elements to Page, Sort, & Filter Across Table or Group Occurrences” on Page 
127. 

Note that any lines containing group fields appear in addition to the number of lines, or 
rows, you specify for paging. 

Also note that you cannot simulate paging in Composer; a simulation returns the first 
page of a document only. Also, paging links call a JavaScript function that is only 
available in a fully installed live environment. 
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Creating a Page Element 

To create a page element:  

1. With the ALF open in Composer, select the table or group to use for the paging 
element. Be sure to select the entire tag.  

2. Right click on the tag and select Paging, then Configure Paging Element 
from the right-click menus. The Modifying Paging dialog appears. 

 

3. Select a paging mode, either By Occurrence (for a group) or By Line (for a table 
or a group). Paging groups by line counts all the contents of the group by the number 
of lines (or rows) returned. Paging groups by occurrence displays the entire group, 
regardless of the number of lines returned.  

4. Enter the number of occurrences (for a group) or lines that will be shown on each 
HTML browser page (for tables and groups). Note that any lines containing group 
fields are not included in this count, but appear in addition to the number of rows you 
specify here. You may want to take this into account when planning your page size.  

5. Enter the number of pages to extract at a time (page set) in Paging Set Size. 
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6. You can enable or disable the system formatting by using the Format Links Internally 
check box. The default is disabled (unchecked); the system does not put any extra 
HTML <TD> tags around paging links at composition time. This is different from 
previous releases where the formatting was automatically added. To enable this 
behavior, you must check this option box. See the next section for more information. 

7. Click OK. 

About Formatting Links Internally 

As mentioned in the previous section, you can enable or disable system formatting for 
page links by using the Format Links Internally check box when you configure paging for 
an element. When enabled, extra <TD> tags surround the paging links (as previous 
releases have defined them). For example, a paging link (PageSet) could be defined as 
follows: 

<TD><font color="#000000"><b> 1</b></TD><TD> | </TD><TD><A 
onclick="this.href=gotoPage(Page(2));"href="about:"> 
2</A></TD><TD> | </TD><TD><A 
onclick="this.href=gotoPage(Page(3));"href="about:"> 
3</A></TD> 

And its actual appearance would be: 

1 | 2 | 3 
 

Caution
 

For backward compatibility with existing applications, the Format Links 
Internally option should be checked. 

With the Format Links Internally option unset, the paging (PageSet) link would appear in 
the HTML output without extra <TD> tags as follows: 

1<A onclick="this.href=gotoPage(Page(2));"href="about:"> 
2</A><A onclick="this.href=gotoPage(Page(3));"href="about:"> 
3</A> 

And its actual appearance would be: 

123 

So, it is the designer’s responsibility to apply suitable separators for a PageSet link. This 
can be achieved by providing the separator string along with the PageSet [E] tag. For 
example, if you want to have the left separator as space and the right separator as space 
and pipe sign, then the paging link [E] tag should look like: 

[E]PageSet("&nbsp;%P&nbsp;|")[/E] 

At the composition time, these two (left, right) separators will reside on the sides of the 
page number. But there won’t be a left separator value for the first page of the current 
PageSet link and similarly there won’t be a right separator value for the last page of the 
current PageSet link. So for the above example, output will look like: 

1 | 2 | 3 

This enables you to have any values as separators. 
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If you choose to eliminate the use of this automatic link formatting, select the existing 
page element in the Application tree view and right-click on it to choose the Modify Page 
Element menu option. You can then uncheck the Format Links Internally option. 
However, if you do this to an existing application, you should also check the format of 
the HTML output as the application is probably defined to expect the extra formatting. 

Creating a Page Set 

To create a page set: 

You must create a paging element before you can create a page set.  

1. Enter text in the template to serve as a placeholder for the paging set tag. 

2. Select the text. 

3. Right-click and select Paging and Insert Paging Set from the right-click 
menu. Composer inserts the paging set tag. 

4. Delete the placeholder text from the template. The remaining tag should look 
something like: [E]PageSet[/E]. 

Inserting Navigational Paging Links 

You can create navigation links in the template to move to a previous or next extracted 
page, to extract the previous or next page set, and to go to the first page.  

To insert page navigational links: 

1. Insert text (such as “Next”) or a graphic to use as a linking object. 

2. Select the object. 

3. Right-click and select Paging and Paging Links from the right-click menu. The 
Select Paging Link Type dialog appears. 

4. Select the appropriate radio button for the paging link type.  

5. Create any additional links.  

6. Save your work. 
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Modifying a Page Element 

To modify a page element: 

1. With the ALF open in Composer, double-click the node in the 
Application Tree. Right-click on the page element and select Modify Page 
Element from the right-click menu. e-Billing Manager displays the Modify Paging 
dialog. 

 

2. Click Edit and modify the page element. 

3. Click OK. 

Removing a Page Element 

To remove a page element: 

1. Either: 

• Right-click on the page element in the Application Tree and select Modify 
Page Element. Click Remove on the Modify Paging dialog. 
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• Right-click anywhere in the template and select Paging and Remove Paging 
Element from the right-click menu.  

2. Click OK when prompted to remove the existing page element. 

Filtering Data 
You can let Web users view a narrow extraction of data based on filtering criteria you 
define in a filter element. You must create a filter on a particular table column then add a 
link to the statement template, which users click to compose the filter. You can filter 
table or group data. 

You can create two types of filter elements: 

• General content-based – To apply a filter to extracted data, producing a narrowed 
view of the data set. You could create a filter to display only those line items past 60 
days due, over $1,000, etc.  

• Top/bottom – To create a counted subset of filtered data based on a configurable 
number of items, from either the top or bottom of the filtered data set. For example, 
you could create a top/bottom filter element to display the top 10 most expensive 
phone calls in a telecomm statement.  

For each filter element (except top/bottom) you must define an expression that compares 
the value in a particular column to either a hard value (date, integer, time, currency 
amount, decimal value, or string), another table column, or a field. For example, a simple 
filter expression for string data consists of a column name followed by an operator (==, 
<, >, <=, >=, etc.) and the comparator, for example: 

AreaCode == “MA” 

You can create a compound filter expression using AND, OR, and NOT operators. For 
details and examples of data filtering expressions, see Appendix A. 

The Simulator lets you validate the format of sort elements; see “Simulating Sorting and 
Filtering Elements” on Page 136. 

Table Filtering 

You can enable Web users to view a filtered subset of table rows using either a general 
content-based filter or a top/bottom counted subset filter. To filter a table, you must 
create a filter element (in table mode) that defines the table and column to filter along 
with filter extraction criteria, then create a filter element link and add it to the statement 
template.  

When a Web user clicks the link, the statement page redisplays with only the table rows 
that satisfy the specifications of the filter element expression.  
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You can create a filter on an individual table or on each occurrence of a table in a group 
(or across group occurrences). To enable filtering across occurrences of a table, create a 
combine element on the table in addition to the filter element. To create a combine 
element, see “Using Combine Elements to Page, Sort, & Filter Across Table or Group 
Occurrences” on Page 127. 

Group Filtering 

You can enable Web users to view only the occurrences of a group that satisfy a general 
content-based filter or a top/bottom counted subset filter. To filter a group, you create a 
filter element (in group mode) identifying the group to filter, along with the filter 
extraction criteria, then create a filter element link and add it to the template. When a 
Web user clicks the link, the statement page redisplays with only the group occurrences 
that meet the specifications of the filter element expression.  

e-Billing Manager filters group occurrences based on the filter column value in the first 
row of the first occurrence of the table in the group. The first occurrence of the table on 
which you define the filter element acts as a “lead table,” and the first row of this table 
occurrence acts as a “lead line” for filtering the group.  

To enable filtering across occurrences of a table and/or group, create a combine element 
on the table and/or group in addition to the filter element. To create a combine element, 
see “Using Combine Elements to Page, Sort, & Filter Across Table or Group 
Occurrences” on Page 127. 

Creating a General Filter Element 

To create a general filter element: 

1. With the ALF open in Composer, right-click the node in the 
Application Tree. 

2. Select Create Filter Element from the right-click menu. The Configure Filter 
dialog appears. 
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3. Select the filter mode to indicate whether the filter is on a table or group. 

4. Enter a descriptive name for the filter. The name must not contain spaces or special 
characters, must start with an alpha character, and cannot exceed 30 characters in 
length. 

5. Double-click the table (or group, if in group mode) you want to filter. If you make a 
mistake, click Clear and reselect the table.  

6. Click  to build a filter expression. The Define Expression dialog 
appears. 
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7. Click  to display the buttons for selecting fields, operators, dates, 
etc. to build an expression in the Add or Change Expression box. Select or enter 
items in the sequence you want them to appear in the expression. (For detailed 
information on Data Filtering Expressions, see Appendix A.) A drop-down menu 
with button selections appears.  

 



Mapping Text Tables and Configuring Elements 

118  |  e-Billing Manager Presentation Design Guide 

8. Click  Data Type  and select the type of data in the column 
or field you want to compare. You do not need to select a data type for a string. 
(Select Currency.) Composer adds the data type and an open parenthesis to the 

expression: . 

9. Click Fields  and select the column or field you want to 
compare. (Select LocalLineAmt.) Composer adds the column name (and a comma, 
if data type is not string) to the expression. 

 

10. If you are filtering on a date, time, decimal, or currency value, click Data Format. 

 

11. Select the format of the data as stored in the input file. (For additional information 
about valid format strings you can enter, see Appendix A.) Composer adds the format 
and a close parenthesis to the expression. Manually add any required separators, as in 
DATE (DueDate, "%m/%d/%Y"). 
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12. Click Operator  and select the appropriate operator for the filter 
expression. Composer adds the operator to the expression: 

. 

13. Click Data Type and select the same data type you selected in the first part of the 
filter expression. Composer adds the data type and an open parenthesis to the second 
part of the expression. 

14. Specify the field, column, date, time, or value for the filter comparator: 

• To specify a date for comparison, click Calendar and choose a specific 
month, year, and day. Composer adds the date in quotation marks, followed by a 
comma, to the expression. 

 

• To specify a time for comparison, click Time. Click the hour, minutes, 
seconds, or AM/PM to highlight, and use the up and down arrows to specify the 

value: . Composer adds the time in quotation marks, followed 
by a comma, to the expression. 

• To specify a currency, decimal, or integer value, enter the value between 
quotation marks followed by a comma. Add a close parenthesis after an integer 
value.  

. 

• To specify a string value, enter the comparator string in quotation marks, as in 

“Massachusetts”. Type quotation marks directly or click . 
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• To compare a string column to a NULL or EMPTY, click Value and select 
NULL or EMPTY. Composer adds the word NULL or EMPTY to the expression. 

• To compare the value to a column or field, click Fields and choose the 
column or field. Note that you can compare a column to a column, pure field, or 
dynamic field. In group mode, you can compare a group field to a group, pure, or 
dynamic field, but not to a column. Composer adds the column or field name in 
quotation marks, followed by a comma, to the expression. 

15. If the data type is a date, time, currency, or decimal, click Data Format and select 
the same format you selected in the first part of the expression. Composer adds the 
format to the expression followed by a close parenthesis. Manually add any 
separators to the second part of the expression, as in: 
DATE ("10/15/2002","%d/%m/%Y"). 

16. When the filter element expression is complete, click Check to verify the integrity of 
the expression. 

17. When the expression is correct, click OK.  

18. Click Add to List. The expression appears in the Expression List. 

  

19. To create a compound expression, click Operator and select AND, OR, or NOT, 
and creating another expression. 

20. Click OK. 

21. Click OK.on the Configure Filter screen. Composer displays the filter name in the 
Application Tree. The “T” next to the filter name indicates it is on a table.  
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22. Click  to save the ALF. 

Creating a Top/Bottom Filter 

Top/bottom filters let you create a counted subset of filtered data from either the top or 
bottom of the filtered data set. For example, you could create a top/bottom filter element 
to display the top ten most expensive phone calls in a telecomm statement.  

To create a top or bottom filter: 

1. With the ALF open in Composer, right-click the node. 

2. Select Create Top/Bottom Element from the right-click menu. The Configure 
Top/Bottom Filter dialog appears. 

 

3. Select the filter mode to indicate whether the top/bottom filter is on a table or group. 

4. Enter a descriptive name for the top/bottom filter. The name must not contain spaces 
or special characters, must start with an alpha character, and cannot exceed 30 
characters in length. 

5. Select the group or table you want to filter. If you make a mistake, click Clear and 
reselect the table. 

6. Select the column you want to filter. If creating a filter on a group, you can select a 
group field. 
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7. Select a data type. 

8. If the data type is a date or time, then select the appropriate format in the Data 
Format field. See Appendix A for more information about data definitions. 

9. If the data type is date or time, click the Validate button  to verify that the format 
in the Data Format field complies with the data type. (See Appendix A for more 
information about data definitions.) 

10. Select a value for the number of data entries you wish to present. 

11. Select the direction of the filter; top or bottom of the data. 

12. If the data type is currency or decimal, select a decimal separator. 

13. If the data type is currency, select a negative separator. 

 

14. Click OK. The top/bottom filter appears under Top/Bottom Elements of the 
Application Tree. The “T” next to the filter name indicates it is on a table. 

 

Linking a Filter Element to a Statement 

After creating a filter element, you must add a link to the statement for users to view the 
filtered data. (You can optionally create a filter or sort element while creating a link.) 
You can create a link on static text, an image, or on an [E] tag. 

You can have a combination of link to view, sort, and filter links in a statement. 
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You can optionally choose to reset the URL as part of the link. This enables you to clear 
any previous URL actions the Web user took, such as sorting or filtering data, before 
applying the filter. If you do not choose this option, the filter would be cumulative on any 
previous URLs the user chose in the session. 

To create a link to a filter element: 

1. With the ALF open, select the item you want to use as a link (be sure to completely 
highlight the item).   

2. Right-click and select Create Link from the right-click menu. The Create Link 
dialog appears.  

 

3. Click Parameters. The Add Parameters dialog appears. 
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4. If you want to display the filtered data in a different view, enter the name of the 
Target View. (You can also add a filter element, sorting element, or a name/value 
pair from dynamic pattern matching to the link.) 

5. Click the Filter Elements or Top/Botton Elements drop-down list and select 
the filter element you want to link.  

 

Tip
 

You can optionally create a sort or filter element from this dialog by clicking 

. See the appropriate procedure in this guide for 
creating the particular element. 

6. Click . Composer adds the filter element to the Added Elements list. 
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7. If you are using more than one sort or filtering function, click Reset URL if you 
want to add the Reset URL function to the link (this clears the history of the previous 
URL before applying this filter).  

8. Click OK. The Create Link dialog appears showing the view name and filter element. 



Mapping Text Tables and Configuring Elements 

126  |  e-Billing Manager Presentation Design Guide 

 

9. Click OK to save the link to the HTML Template. Composer adds a blue hyperlink to 
the statement.  

10. Save the template by clicking . 

11. Click  to save the ALF if you added a link to a table column. 

Modifying a Filter Element 

To change the properties of a filter element: 

1. With the ALF open in Composer, right-click the filter element (general or 
top/bottom) and select Modify Filter Element (or Modify Top/Bottom 
Element) from the right-click menu. Composer displays the Configure Filter (or 
Configure Top/Bottom Filter) dialog. 

2. Edit a top/bottom filter as needed, or click Wizard to edit a general filter. To delete 
one or more expressions from a compound filter element, select the expression and 
click Delete Expression.  

3. Click OK. (Click OK again if editing a general filter.) 

Deleting a Filter Element 

To delete a filter element: 

• With the ALF open in Composer, right-click the filter element (general or 
top/bottom) and select Delete Filter Element (or Delete Top/Bottom 
Element) from the right-click menu.  
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Using Combine Elements to Page, Sort, & Filter 
Across Table or Group Occurrences 

Creating a combine element on a group or table lets you to “combine” occurrences of 
groups or tables when paging, sorting, or filtering a statement.  

Defining a table or group as a combine element eliminates breaks across occurrences of 
the group or table for all page, sort, and filter (general or top/bottom) elements defined 
for the group or table.  

Creating a combine element lets the Web user: 

• Click through fewer pages to view a statement. By default, paging elements start a 
new Web page for each new table or group occurrence, regardless of how many rows 
are in each table, often not filling the entire page. Creating a combine element on a 
table or group eliminates page breaks at the end of the group or table occurrence, 
displaying them contiguously, requiring fewer pages. Paging lets you display a 
consistent number of HTML lines per page. (You must create a page element on the 
table or group to configure the paging feature; see “Creating a Page Element” on 
Page 110.) 

• Sort or filter (general or top/bottom) statement data across all table or group 
occurrences. By default, e-Billing Manager sorts or filters each occurrence of a 
table. Creating a combine element on a table or group lets users sort or filter data 
across all occurrences of the table or group. (You must create a sort or filter element 
on the table or group to configure these features; see “Sorting Tables” on Page 100 or 
“Filtering Data” on Page 114.) 

Create a combine element wherever it makes sense to remove the boundaries of table or 
group occurrences and let users page, sort, or filter across this statement data.  

Unlike other element types, you do not create a link for a combine element. 

You define combine elements in the default ALF only, however e-Billing Manager 
applies the combined property to any elements that appear in any switch ALFs. 

 

Caution
 

If you create a combine element on a group that has group fields at that 
level, e-Billing Manager displays the value in the first occurrence of the 
group only.  The data associated with the group field in subsequent 
occurrences of the group does not appear, and is effectively lost to the 
viewer.  (Group fields below that level still appear with each occurrences.) 

Creating a New Combine Element 

To create a new combine element: 

1. Creating With the default ALF open in Composer, right-click the  
node in the Application Tree. 

2. Select Configure Combine Elements from the right-click menu. Composer 
displays the Configure Combine Elements dialog.  
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3. Select the group or group table on which you want to combine occurrences. 

4. Select any additional groups or group tables to create additional combine elements (if 
any). 

5. Click OK. 

Viewing and Deleting Combine Elements 

To view a list of or delete combine elements: 

1. With the default ALF open in Composer, right-click .  

2. Select Configure Combine Elements from the right-click menu. Composer 
displays the Configure Combine Elements dialog. 

3. You can see the complete list of combine elements for the view listed under Added 
Combine Elements.  

To delete a combine element, select the element from the list and click Remove. (To 
remove all combine elements, click Remove All.) 

4. Click OK. 
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Totaling with Arithmetic Elements 
You can create an arithmetic element to calculate and display the sum of all values in a 
table column or the total number of rows in a table (line count). Arithmetic elements let 
you create subtotals or totals not provided in your application’s data input file. You can 
also calculate totals of sorted or filtered data. You can create an arithmetic element on a 
group field and place it anywhere on a template, on any hierarchy. 

You can use arithmetic elements with paging, however, if you do not also sort or filter 
the data, you can only display a total at the end. (Paged data extracts progressively, and 
is therefore not available for summing until the last set displays. If you sort or filter the 
data when paging, however, data extraction is not progressive, and is extracted and 
available for subtotaling individual tables in a group for display on each page.)  

You can configure an arithmetic element to create a total for: 

• A single occurrence of a table (one total for one occurrence of a table, also called a 
“pure table”) 

• Each occurrence of a table (a total for each table occurrence in a group) 

• Each occurrence of a group (one total for all tables in a group occurrence) 

• All occurrences of a table across all occurrences of a group (one total for the 
statement) 

Once you configure the arithmetic element for a table, you must drag and drop the 
arithmetic element to the appropriate place in the default HTML template or in the group 
template. The value e-Billing Manager calculates depends on where you place the 
arithmetic element in the statement:  

• In the default HTML template - To total a column in a single occurrence of a table 
or to generate one grand total of column data across all occurrences of a table, add 
the arithmetic element directly to the default HTML template.  

• In the group HTML - To calculate a total on each occurrence of a group, place the 
arithmetic element in the group template. To calculate a total for each table 
occurrence in a group, add an HTML table to the group template and place the 
element inside the table. (This behaves like a footer to the table section in the ALF 
and calculates a total for each group occurrence.) 

You can total the values in a column of data that contains a time, currency, integer, or 
decimal value only. You can calculate a line count on any type of column. 

For time, currency, and decimal values, you must specify how the data is stored in the 
input file (time requires a strptime data format). You can also specify the output format, 
as well as any text or characters to display with the output, such as “Total:” and a 
currency symbol ($, £, etc.). 

Specifying output format with the arithmetic element (vs. directly on the template) is 
necessary when calculating a subtotal for each table in a group or when you apply paging 
without also sorting or filtering. The system can’t compose a sum until all data has been 
extracted with the final page, and you wouldn’t want the words “Total:” or other output 
formatting to appear on every page without the sum or count. 
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Caution
 

Be sure to specify the correct data format in the arithmetic element. If 
some rows of data match the specified data format and others do not, e-
Billing Manager includes only matching rows in the total. When you 
validate elements, Composer reports the non-matching rows. 

Creating a New Arithmetic Element 

To create an arithmetic element and add it to your statement: 

1. With the ALF open in Composer, right-click the node in the 
Application Tree, and select Create Arithmetic Element. Composer displays 
the Configure Arithmetic Element dialog: 

 

2. Enter a meaningful name for the arithmetic element. (Enter PhoneLineCount.) 

3. Expand the Tables or Groups node and select the table you want to create an 
element on (element hierarchy). 
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4. Double-click on the column or field you want to total or count. The element can be a 
group field. 

5. Select the type of arithmetic element you want to create, either sum or count, from 
the Mode drop-down list under Format Configuration. 

6. If the arithmetic element is to sum values, select the type of data in the column: time, 
currency, integer, or decimal, then specify the following data input and output 
information.  

Time: Select or enter the strptime format used in the input file. Click the  button 
to verify its validity. Click the Apply button under Input Format, then select or enter 
the format you want to use to display the output, and click the Apply button under 
Output Format. 

Currency: Specify the decimal and negative separators used in the input file, and 
click the Apply button under Input Format. Specify the thousand, decimal, and 
negative separators and the number of decimal digits to use to format the output, and 
whether you want it to appear before or after the number, and inside or outside of 
brackets () (if you selected brackets as the negative sign). Click the Apply button 
under Output Format 

Decimals: Specify the decimal separator used in the input file, and click the Apply 
button under Input Format. Then specify the thousand and decimal separators and 
number of decimal digits to use for the output format, and click the Apply button 
under Output Format.  

 

Caution
 

Be sure to choose a data output format with enough digits to display the 
potential sum value (otherwise digits could be cut off). 

7. Click OK. Composer displays the arithmetic element in the Application Tree: 

 

8. Add the arithmetic element to the statement: 

• To total a column in a single occurrence of a table or to generate one grand 
total of column data across all occurrences of a table, click and drag the 
arithmetic element from the Application Tree to the default HTML template.  

• To calculate a total on each occurrence of a group, place the element in the 
group HTML template; select the table, right-click and select Configure 
Table from the right-click menu. Click-and-drag the element from the 
Application Tree to the group HTML template. 

• To calculate a total on each occurrence of a table, place the element in the 
group HTML template; select the table, right-click and select Configure 
Table from the right-click menu. Add an HTML table to the group template and 
drag-and-drop the arithmetic element inside the table. (This behaves like a footer 
to the table section in the ALF and calculates a total for each table in the group.) 

9. Click  to save the ALF. 
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Modifying an Arithmetic Element 

To modify an arithmetic element: 

1. With the ALF open in Composer, double-click the  node to 
display a list of arithmetic elements in the Application Tree. Right-click the 
arithmetic element you want to edit. 

2. Select Modify Arithmetic Element from the right-click menu. The Configure 
Arithmetic Element dialog appears. 

3. Edit the properties of the element as you did when adding the new element, and click 
OK. 

Deleting an Arithmetic Element 

To delete an arithmetic element: 

1. With the ALF open in Composer, double-click the  node to 
display a list of arithmetic elements in the Application Tree. Right-click the 
arithmetic element you want to delete. 

2. Select Delete Arithmetic Element from the right-click menu. Composer asks if 
you’re sure you want to delete the element: 

 

3. Click Yes. Composer removes the arithmetic element from the ALF. 

4. Manually remove the [E]ElementNameA[\E] tag from the correct HTML template. 
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Running a Simulation 
Use Composer’s Simulator feature to view the customized presentment of statement data 
as it would appear live in a browser. Simulator uses the DDF, ALF, and HTML templates 
to deliver a composed HTML version of the statements using a sample data input file. 
Simulator prevents the “blind design” technique often associated with application 
development. You can run the Simulator at any time during the development process. 

You can enter values and check individual dynamic fields. Simulator also lets you select 
sort and filter elements to validate. You must select and validate each sort element define 
on the same table one at a time. By default, Simulator verifies all arithmetic elements 
used in the templates, reporting the results in the Data Type Report. (You can turn this 
option off.) 

When you select elements to validate, Simulator generates the Data Type Report with the 
simulation results. You can view the report online, print, and/or save the log to a file. 

To run a simulation: 

1. Select View>Simulate or click  on the Simulator toolbar. The Simulate dialog 
appears. 
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2. Select a data file. 

3. Specify the page range to include in the simulation. 

4. If you are simulating using dynamic field values, see “Simulating Dynamic Field 
Values.” 

5. If you are simulating sort or filter elements, see “Simulating Sorting and Filtering 
Elements.” 

6. Click OK. The Simulate Bar appears displaying a composed HTML view of each 
statement appears in the right-pane and a simulated listing of the data.  

  

7. To view the statements, click the navigation icons   on the Simulator toolbar 
or click on the pages in the simulated document. 

 

Tip
 

You can drag and drop columns to change their position in the “hit list,” 
which is useful for comparing columns. 

8. To return to the uncomposed HTML statement work area, click the toggle icon . 

9. After editing, click the refresh icon  to refresh the simulation without navigating 
to a sample data source. 

Simulating Dynamic Field Values 

To simulate dynamic field values: 

1. While simulating the statement, from the Simulate dialog, click Dynamic Field 
Values. The Apply Dynamic Field Values dialog appears.  



Using the Simulator 

e-Billing Manager Presentation Design Guide  |  135 

 

2. Click to select the dynamic field for simulation. Selecting a dynamic field will list the 
associated names where the dynamic field is used in the DDF data elements in the 
Associated Marker(s)/Columns(s)/Table Anchors(s)” List Box. 

3. Double-click in the Value field to enter the dynamic value. 

Click Save to save the field values to the registry. 

Click Remove All to remove all dynamic field values from the registry. 

Click Remove to remove the selected dynamic field value from the registry. 

4. Click OK. The Simulate dialog appears. 

5. Click OK. The Simulate Bar appears with a composed HTML view of each statement, 
with the dynamic field values in the right-pane. 

 

Caution
 

Simulator continues to apply the dynamic field value for subsequent 
simulations. To remove the value, double-click in the Value field on the 
Apply Dynamic Field Values dialog and remove the value. 
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Simulating Sorting and Filtering Elements 

To simulate sorting and filtering: 

1. While simulating the statement, from the Simulate dialog, click Dynamic Field 
Values. The Validate Elements dialog appears. 

 

2. Select the filters and/or sort elements you want to sort from the Available Elements 

list and click  to place it in the Added Elements list. (You can also double-
click on an element to move it from one window to the other.) You can only select 
and validate one sort element defined on table at a time.  

3. If you want Simulator to validate all arithmetic elements placed in the templates, 
check the “Validate all Arithmetic element(s) in use” option. 
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4. Click OK. The Simulate dialog appears. 

5. Click OK. The Simulate Bar appears with a composed HTML view of each statement 
with the sorted and filtered data only appearing in the right-pane. 

6. Click the Data Type Report icon  in the Simulate tool bar. Composer displays the 
Data Type Report dialog. Scroll down the report to view element details. 
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7. To save the Data Type Report information as a text document with a time stamp as 
the filename, click . 

8. To print the Data Type Report, click . 

9. Click OK. Composer prompts you to save the log if you have not. 
 

Caution
 

Composer continues to apply the added elements to subsequent 
simulations. To remove the elements, enter the Apply Dynamic Field 
Values dialog, select the element in the Added Elements list and click 

 (or double-click on the element). 
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Chart Information in the ALF 
You can drag and drop the tables defined in the DDF into the HTML template using the 
WYSIWYG or the HTML editor. You can represent a table as either a text table or as a 
chart in the HTML template. 

 

Tip
 

The charting option is NOT available for a table with only one field. 

To create a chart: 

1. Click the WYSIWYG tab or HTML tab. 

2. Click the Definition tab in the Tree. 

3. Click to open Tables in the Tree. 

4. Drag and drop the table  definitions into the HTML template. The table assumes 
the properties of the area in which it is placed. (Drag and drop the 
LocalChargeSummary table to the HTML Template.) 

 

5. Select Chart. 
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6. Select a field for the X axis of the chart. 

7. Select a field for the Y axis of the chart. 

8. Select the type of chart. 

9. Select the width and height settings for the chart.  

10. Enter the URL path. (Enter the path to the Web Server chart storage area.) 
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11. Click OK. At this point a place holder for the chart is added to the template and a 
properties files is created. Example: If the table name is Test then a 
“Test_0.Properties file is created in the AppProfiles\DDN Name directory (Where the 
ALF and Templates are located). When creating a chart, make sure that there is more 
than one field in the table and that there are numeric values included. Even though 
the field type is not numeric, the values are converted into a numeric format by the 
Chart engine. 

12. If there are placeholders in the HTML template, delete them. 

13. Click the Save Template icon .  

14. Save the ALF by clicking the Save ALF icon . 
 

Tip
 

When mapping a table to a template in the Composer, it is not necessary 
to encapsulate the table with HTML table row <TR> and table data <TD> 
(cell) tags. The table rows and table data (cells) are generated when the 
data is dynamically pulled from the data file and passed to the edocs 
WebComposer object. This object formats the table rows, cells, and font 
characteristics of the data based on the settings defined in the Composer. 

Charting Attributes 

For a e-Billing Manager view to display charts, an ALF must be constructed and placed 
in the view directory. The ALF will provide the document type definition (DTD) in the 
ALF (usually at the beginning of the document).  

The DTD will have the attributes (described here ) assigned to the chart. 
 

Attribute Name Meaning 

Height Total height of the canvas 

Width Total width of the canvas 

HidePieLegend Toggles the display of legends for Pie charts 

AddValueToLegend Displays the percentage in the chart legend 

BaseURL Points to the location where the chart images are stored 

UnixChart Chart types in a UNIX platform 

You will notice other attributes listed in the ALF. These attributes are placed in the ALF 
for backward compatibility with previous versions of e-Billing Manager and have no 
effect on the current version. 
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Chart Information Contained Within the ALF 
You can see the HTML for the chart. For example, after defining your table properties 
and saving your ALF, open the ALF in Notepad and scroll down to the [CHARTS] 
section. There you will find the HTML that will be pulled into the Statement Template 
during assembly (when the chart tags are found). Here is an example of chart 
information: 

<CHARTS><Chart Name = “LocalChargeSummary_0”RecordName = 
“LocalChargeSummary”TopTitle = “”BottomTitle = “”LeftTitle = 
“”RightTitle = “”XField = “LocalChargeDesc”YField = 
“LocalChargeAmount”Key = “1”StackedStyle = “0”ColorScheme = 
“0”GridLines = “3”Full3D = “1”AngleX = “45”AngleY = 
“0”Atribute = “109577474”MarkerVolume = “3”Shadow = 
“1”MultiShape = “11”Dimension_3D = “1”View3DDepth = “80”Type = 
“0”CGITimeSpan = “”BackgroundColor = “”ForgroundColor = 
“”Height = “300”Width = “400”LegendShow = “1”LegendToolSize = 
“100”LegendToolStyle = “167116800”HidePieLegend = 
“0”SeriesColor = “”LeftGap = “40”RightGap = “40”ImgQuality = 
“75”ImgSmooth = “0”AddValueToLegend = “0”BaseURL = “”UNIXChart 
= “”></Chart></CHARTS> 

Chart Properties 

The chart properties file is a list of name-value pairs that control the type of chart, 
location of the axes, fonts, colors, whether to use three-dimensional effects, etc. To 
change the display of some aspect, an alternate value for the controlling property must be 
provided. If there is a conflict between a chart attribute defined in the ALF and a value 
defined in the chart property, it will override the chart attribute. 

The chart properties file is included as part of your published application view using the 
edocs Command Center. Publishing views are described in detail in the e-Billing 
Manager Administration Guide. Publishing chart views follows the same general process.  

The following summarizes the parts specific to charts:  

• In the Publisher window, select the Create button. Set values for ddn, job type, and 
viewName (for example, “NatlWireless”, "HtmlDetail", and "Cell_0"). 

• In the next window that pops up, in the Web-Views section, which is also the upper 
portion of the page, select the option "Chart 0". You are next requested to specify, 
through your file system, the chart properties file. A file extension of .properties is 
required.  

The following sections describe the types of properties included in the file. 
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Chart Type 

The primary chart property is Type. By setting Type = Pie, one obtains a Pie chart, using 
“Bar” instead, results in a bar chart. The table below itemizes the various chart types 
currently available to e-Billing Manager running on Unix platforms. Note that the “Type” 
property and its value are both case-sensitive. The remainder of the properties and their 
values are not so limited.  

 
Bar HiLoBar HorizBar HorizHiLoBar 

IndBar LabelLine Line Pie 

Polar StackBar StackColumn Speedo 

Stick StickBar Regress  

The following are issues related to the chart types: 

• Do not set properties that are not applicable to a chart type. For example, do not set 
Axis properties when requesting a Pie chart.  

• Do not set Bar properties while rendering a Pie chart. For charts created using the 
Composer tool, the chart types: HiLobar, HorizHiLoBar, and Speedo are not 
available. 

• If you want a Bar chart that displays elements of individual data series in different 
colors, select the IndBar type. 

Chart General Properties 

General chart properties determine whether the legend should be displayed, whether to 
provide three-dimensional effects, and finally whether to display the axis. Note that for 
Pie type charts, the convention is not to display the axis. For example: 

Chart.LegendVisible=false 

Chart.Name=MyChart 

Chart.XAxisVisible=true 

Chart.YAxisVisible=true 

Chart.ThreeD=false 

## the XOffset and YOffset determine the amount of three 
## dimensional effect along the X and Y axes respectively. 

Chart.XOffset=0 

Chart.YOffset=0 

Chart.Quality=1 

The Quality property defaults to 1 for the highest quality image possible. A value of 0 
sets it to a lower quality image. 
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Background Properties 

Titles and sub-titles are elements of the chart background. Their color, font and string 
value are controlled by appropriately setting the following background properties: 

## Red, Green and Blue values, valid values 0-255 
##  
Background.Gc.FillColor.Red=0 
Background.Gc.FillColor.Blue=0 
Background.Gc.FillColor.Green=0 

Background.Gc.LineColor.Red=0 
Background.Gc.LineColor.Blue=0 
Background.Gc.LineColor.Green=0 

Background.Gc.LineWidth=1 

Background.Gc.MarkerColor.Red=0 
Background.Gc.MarkerColor.Blue=0 
Background.Gc.MarkerColor.Green=0 

Background.SubTitleColor.Red=0  
Background.SubTitleColor.Blue=0  
Background.SubTitleColor.Green=0 

Background.SubTitleFont.name=TimesRoman 
Background.SubTitleFont.style=plain 
Background.SubTitleFont.size=12 

Background.SubTitleString=null 

Background.TitleColor.Red=0  
Background.TitleColor.Blue=0  
Background.TitleColor.Green=0 

Background.TitleFont.name=TimesRoman 
Background.TitleFont.style=plain 
Background.TitleFont.size=12 

Background.TitleString=null 

Plot Area Properties 

The plot area is the region bounded by the axis; where the data is actually plotted. The fill 
color for this region, in addition to the marker and grid line particulars, may be specified. 
For example: 

Plotarea.Gc.FillColor.Red=0 
Plotarea.Gc.FillColor.Blue=0 
Plotarea.Gc.FillColor.Green=0 

Plotarea.Gc.LineColor.Red=0 
Plotarea.Gc.LineColor.Blue=0 
Plotarea.Gc.LineColor.Green=0 

Plotarea.Gc.LineWidth=1 

Plotarea.Gc.MarkerColor.Red=0 
Plotarea.Gc.MarkerColor.Blue=0 
Plotarea.Gc.MarkerColor.Green=0 
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Axis Properties 

The axis properties control the location of the axis on the canvas, its major and minor 
ticks, title, grid, and labels. Note that while only the X axis properties are presented 
below, an identical set of properties exist for the Y axis that starts with “Y.” instead of 
“X.”. For example: 

## to skip labels that collide 
## meaningful if the user can guess the missed labels 
## generates a more legible axis without having to reduce  
## font size or increase the chart height or width. 
## 
X.Axis.CullingLabel=false 

## Useful most times 
## 
X.Axis.AutoScale=true 

## ending point for the axis. For AUTO_SCALE, the axis 
## end will be automatically determined. For log-scaled, it is 
## a power of ten 
## 
X.Axis.AxisEnd=6.0 

## starting point for the axis. For AUTO_SCALE,  
## the axis start will be automatically 
## determined. For log-scaled, it is a power of ten 
## 
X.Axis.AxisStart=0.0 

## place bar within axis, set true for bar charts 
## 
X.Axis.BarScaling=true 

## Display grid lines 
## 
X.Axis.GridVis=false 

## Tilts the label by amount specified, integer value 
## 
X.Axis.LabelAngle=0 

## Axis label color 
## 
X.Axis.LabelColor.Red=0 
X.Axis.LabelColor.Blue=0 
X.Axis.LabelColor.Green=0 

## Axis Label Font 
## 
X.Axis.LabelFont.Name=TimesRoman 
X.Axis.LabelFont.Style=plain 
X.Axis.LabelFont.Size=12 

## For double quantities such as currency 
## 
X.Axis.LabelPrecision=2 

## Determines whether the label is visible 
X.Axis.LabelVis=true 
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## Determines whether the axis line is visible 
X.Axis.LineVis=true 

## Determines whether the scale is log based 
## 
X.Axis.LogScaling=false 

X.Axis.MajTickLength=5 

X.Axis.MajTickVis=true 

X.Axis.MinTickLength=2 

X.Axis.MinTickVis=false 

X.Axis.NumGrids=5 

X.Axis.NumLabels=5 

X.Axis.NumMajTicks=5 

X.Axis.NumMinTicks=10 

## reduce LlX to left shift axis position on canvas 
##  increase for right shift, that is along the X direction 
## 
X.Axis.Plotarea.LlX=0.2 

## reduce LlY to move lower on axis on location  
## increase LlY to raise axis, that is along Y direction 
X.Axis.Plotarea.LlY=0.2 

## similar to LlX and LlY, but controls upper right corner  
## 
X.Axis.Plotarea.UrX=0.8 
X.Axis.Plotarea.UrY=0.8 

## places axis on left, right, top  or bottom 
## 
X.Axis.Side=1 

X.Axis.TitleColor.Red=0 
X.Axis.TitleColor.Blue=0 
X.Axis.TitleColor.Green=0 

X.Axis.TitleFont.Family=Times New Roman 
X.Axis.TitleFont.Name=TimesRoman 
X.Axis.TitleFont.Style=plain 
X.Axis.TitleFont.Size=12 

X.Axis.TitleString=Remember to set X axis title! 

X.Axis.GridGc.FillColor.Red=0 
X.Axis.GridGc.FillColor.Blue=0 
X.Axis.GridGc.FillColor.Green=0 

X.Axis.GridGc.LineColor.Red=0 
X.Axis.GridGc.LineColor.Blue=0 
X.Axis.GridGc.LineColor.Green=0 

X.Axis.GridGc.LineWidth=1 

X.Axis.GridGc.MarkerColor.Red=0 
X.Axis.GridGc.MarkerColor.Blue=0 
X.Axis.GridGc.MarkerColor.Green=0 
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## valid values = Left, Right, Top, Bottom 
## 
X.Axis.Side=Left 

X.Axis.TickGc.FillColor.Red=0 
X.Axis.TickGc.FillColor.Blue=0 
X.Axis.TickGc.FillColor.Green=0 

X.Axis.TickGc.LineColor.Red=0 
X.Axis.TickGc.LineColor.Blue=0 
X.Axis.TickGc.LineColor.Green=0 

X.Axis.TickGc.LineWidth=1 

X.Axis.TickGc.MarkerColor.Red=0 
X.Axis.TickGc.MarkerColor.Blue=0 
X.Axis.TickGc.MarkerColor.Green=0 

X.Axis.LineGc.FillColor.Red=0 
X.Axis.LineGc.FillColor.Blue=0 
X.Axis.LineGc.FillColor.Green=0 

X.Axis.LineGc.LineColor.Red=0 
X.Axis.LineGc.LineColor.Blue=0 
X.Axis.LineGc.LineColor.Green=0 

X.Axis.LineGc.LineWidth=1 

X.Axis.LineGc.MarkerColor.Red=0 
X.Axis.LineGc.MarkerColor.Blue=0 
X.Axis.LineGc.MarkerColor.Green=0 

If your labels appear too close together on the X-axis, there is an alternative. You can 
place legends on the side, top, or bottom by specifying the chart property 
Chart.Legend.Visible=true and by specifying the values for height, width, and 
colors for the icons. Turn off the parts of the X-axis labels with the LabelVis property. 

Legend Properties 

The legend or a key for a chart are controlled by the following properties: 
Legend.BackgroundVisible=true 

## separation between rows of the legend 
## 
Legend.IconGap=0.02 

## Legend icon height 0 < k < 1.0,  
## where 1.0 = full height of canvas 
## 
Legend.IconHeight=0.05 

## Legend icon width 0 < k < 1.0,  
## where 1.0 = full width of canvas 

Legend.IconWidth=0.07 

## Red, Green and Blue values, valid values 0-255 

Legend.LabelColor.Red=0 
Legend.LabelColor.Blue=0 
Legend.LabelColor.Green=0 
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## Legend Font 
## 
Legend.LabelFont.Name=TimesRoman 
Legend.LabelFont.Style=plain 
Legend.LabelFont.Size=12 

## Legend lower x left corner 0 < y < 1.0,  
## 1.0 = full width 

Legend.LlX=0.0 

## Legend lower y left corner 0 < y < 1.0, 1.0 = full height 
## 
Legend.LlY=0.0 

## Legend upper x right corner 0 < y < 1.0, 1.0 = full width 
## 
Legend.UrX=0.0 

## Upper y right corner 0 < y < 1.0, 1.0 = full height 
## 
Legend.UrY=0.0 

## true for Legend below chart  
## 
Legend.VerticalLayout=false 

## The following properties change a Legend’s graphic  
## component.  
## 
Legend.BackgroundGC.Gc.FillColor.Red=0 
Legend.BackgroundGC.Gc.FillColor.Blue=0 
Legend.BackgroundGC.Gc.FillColor.Green=0 

Legend.BackgroundGC.Gc.LineColor.Red=0 
Legend.BackgroundGC.Gc.LineColor.Blue=0 
Legend.BackgroundGC.Gc.LineColor.Green=0 

Legend.BackgroundGC.Gc.LineWidth=1 
 
Legend.BackgroundGC.Gc.MarkerColor.Red=0 

Legend.BackgroundGC.Gc.MarkerColor.Blue=0 
Legend.BackgroundGC.Gc.MarkerColor.Green=0 

Favorite Colors Properties 

The properties file allows you to specify your favorite colors, to use as fill color for data 
slices. You can specify favorite colors to ensure a pleasing overall color scheme, in 
particular you may want your chart colors not to clash with the colors used in the page 
embedding the chart. The total number of favorite colors and their order of specification 
are important to bear in mind for the following reasons: 

• Number: Favorite colors become active if there are enough of them to meet display 
needs. For example, if a Pie has “n” distinct slices, where n is greater than the 
number of favorite colors specified, the favorite colors will not be used. This is 
because there is no way to guess which colors would go well with those already 
specified. 
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• Order: The favorite colors are used in the order specified, so it is your responsibility 
to ensure that a color is distinct and distinguishable from its adjacent colors. Or else 
as in the case of a Pie chart, the resulting chart may not provide enough contrast  

For example, the following defines the first and second favorite colors: 
Favorite.1.Color.Red=201 
Favorite.1.Color.Blue=92 
Favorite.1.Color.Green=132 

Favorite.2.Color.Red=51 
Favorite.2.Color.Blue=52 
Favorite.2.Color.Green=53 

Pie Properties  

The pie properties are available only when the selected chart type is Pie. These control 
the pie height, pie width, location of pie center on the canvas, and how the labels and 
legends must appear. For example, should the percentage sign be tacked on? Should the 
pie slice size be shown?  Below is the list of various Pie properties along with their 
default values. Note that color and font related properties are broken into their primitive 
constituents. 

Pie.LabelPosition=2 

Pie.StartDegrees=0 

## true displays pie slice name, e.g., “College Fund” 
Pie.TextLabelsOn=false 

## true displays the size of pie slice numerically, e.g.,30.5 
Pie.ValueLabelsOn=false 

## true turns on the % sign after the pie slice size, e.g., 
30.5% 
Pie.PercentLabelsOn=true 

## Pie Label Color 
## 
Pie.LabelColor.Red=0  
Pie.LabelColor.Blue=0  
Pie.LabelColor.Green=0  

## Pie Label Font,  
## font names and style are the same as in java.awt.font 
## 
Pie.LabelFont.Name=TimesRoman 
Pie.LabelFont.Style=plain 
Pie.LabelFont.Size=12 

## To obtain a circular Pie, scale height and width using  
## true canvas height and width to be equal in pixels.  
## For width = 300 and height = 200, 
## to obtain a Pie radius of 100, use: 
## 
Pie.Height=0.5 
Pie.Width=0.33 
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## Locate Pie center. Take into consideration length of labels 
## in legend and whether the legend will be  
## displayed horizontally or  vertically  
## 
Pie.XLoc=0.5 
Pie.YLoc=0.5 

If your labels appear too close together, there is an alternative. You can place legends on 
the side, top, or bottom by setting the chart property Chart.Legend.Visible=true 
and by specifying the values for height, width, and colors for the icons (see the Legend 
Properties section above). Turn off the label by setting the TextLabelsOn, 
ValueLabelsOn, and PercentLablesOn properties to false. 

Bar Properties 

The following properties control how bars are displayed in Bar Charts: 
## Set the Bar baseline. 
## 
Bar.Baseline=0.0 

## sets the cluster width 
## 
Bar.ClusterWidth=0.8 

## Set to true to clip bars at Plotarea boundaries. 
## 
Bar.DoClip=false  

Line Properties 

Set to true to clip lines at the plot area boundary: 
Line.Clip=false 

Example: 

The following is an example of a Pie chart and its non-default property settings: 
Pie.Height=0.5 
Pie.Width=0.33 

Chart.LegendVisible=true 
Legend.IconGap=0.02 
Legend.IconHeight=0.05 
Legend.IconWidth=0.07 
Legend.LabelColor.Red=123 
Legend.LabelColor.Blue=126 
Legend.LabelColor.Green=129 
Legend.LlX=0.7 
Legend.LlY=0.4 
Legend.VerticalLayout=false 
Pie.PercentLabelsOn=true 
Pie.TextLabelsOn=false 
Pie.ValueLabelsOn=true 
Pie.XLoc=0.5 
Pie.YLoc=0.5 
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Changing Chart Properties 
Changing chart properties is similar to the initial creation of a chart. 

To display the properties of a chart: 

1. In the Application Tree click to open the Charts  , and right-click on the chart  
you want to modify.  

2. Select Properties from the right-click menu. The Chart Properties dialog box 
appears. 

 

Deleting Charts 

To delete a chart: 

1. In the Application Tree click to open the Charts  , and right-click on the chart  
you want to delete. 

2. Select Delete Chart from the right-click menu. 

3. A message appears asking you to confirm the delete operation. 

4. Click Yes. 
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Appendix A: Data Definitions 

EBNF Description 
EBNF (Extended Backus-Naur Form) is a language described by sets of rules, syntax, 
tokens etc. Specify one or more syntactic groupings and give rules for constructing the 
language. For example, in C language, one kind of grouping is called an ‘expression.’ 
One rule for making an expression might be, “An expression can be made of a minus sign 
and another expression”.  

Expression ::= - Expression  

Rules are often recursive, but there must be at least one rule that leads out of the 
recursion. EBNF’s repetition is constructed so that an expression has only one derivation. 

The most common formal system for presenting such rules that people can read is called 
EBNF — a context-free grammar. 

Data Definitions 
Data definitions supported by e-Billing Manager for use with the EBNF expression 
language are: 

• String — Delimit by double quotes.  
Example: “foo” , “00012”, “508-467-9887” 

• Integer — Format ( + | - | )(0-9)(0-9)*  
Grouping separator for thousands can be a DCHAR ( . or , )  
Example: 10, 35, 10034, -3462 etc. 

• Double/Float — Format of ( + | - | )(0-9)(0-9)*. (0-9)(0-9)* 
This is a double precision value, i.e. a decimal value. 
Example: 0.0, -10.23, 10089.4658 

• Date — Format where DD is the day, MM is the month, YY/YYYY is the year of 
format (0-9) and Mmm/ Mmmmm is the three-character month name and the full 
name of the month respectively.  
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• Time — HH stand for hours, MM for minute, and SS for seconds of format (0-9) 
[AM|PM]. 

• Currency — According to the following format: 
 ( + | - | ( | ) (0-9)(0-9)*. (0-9)(0-9)* ( - | ) | CR | | DB | ) 
In addition, the currency symbol can appear in the data.  
The currency format can change according to the location. 

INT(data) — Convert the parameter passed as a string to an integer. The characters in the 
string must all be digits and spaces. 

DOUBLE(data, “decimal separator sign”) — Convert the parameter passed as a string 
to double/float value. The characters in the string must all be digits, spaces plus the 
decimal separator sign. 

CURRENCY(data, “decimal separator sign”, “negative format string” ) — Convert the 
parameter passed as a string to double/float value. The negative format string can be 
“CR”, “DB” etc., and the decimal separator sign can be “.”, “,” etc. Data could also have 
other characters in the string, such as: “$ 1, 000, 000 . 00 CR”.  

 

Currency Example Notes 

4,123,978.999- Trailing negative + three decimals 

4,123,978.99- Trailing negative 

-4,123,978.99 Leading negative 

-4,123,978.999 Leading negative + three decimals 

4,123,978.99CR Trailing CR (credit) 

4,978.99 CR Trailing CR separated by space 

4,123,978.999CR Three decimals, trailing CR (credit) 

4,978.999 CR Three decimals, trailing CR separated by space 

4,123,978.99DB Trailing DB (Debit) 

4,978.99 DB Trailing DB separated by space 

4,123,978.999DB Three decimals, trailing DB (Debit) 

4,978.999 DB Three decimals, trailing DB separated by space 

DATE(data, format_string) — Convert the parameter passed as a string to Date value. 

TIME(data, format_string) — Converts the parameter passed as a string to the Time 
value. 
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Date/Time Format String Components 

Format Description English French 

%% Parse literal ‘%’   

%a Day of week using the locale's 
weekday names (abbreviated 
name) 

Fri ven 

%A Day of week using the locale's 
weekday names (long name) 

Friday vendredi 

%b Month using the locale's month 
names (abbreviated name) 

Jun jun 

%B Month using the locale's month 
names (full name) 

June juin 

%c Locale-appropriate date and time 
representation (abbreviated form)

Fri Jun 08 17:53:28 
2002 

ven 08 jun 2002 
17:50:58 EDT 

%C Locale-appropriate date and time 
representation (full form) 

  

%d Day of month [1-31]; leading zero 
is permitted but not required 

8 
08 

 

%D Date as %m/%d/%y.   

%e Same as %d.   

%G One digit of fractional seconds. 
Leading zero is permitted but not 
required.  
Fractional second value 
increments in six second 
intervals; e.g., .1=6 seconds, 
.7=42 seconds 

.6 or 0.6 both 
equivalent to 0:36 

 

%h Same as %b. Jun jun 

%H Hour (24-hour clock) [0-23]. 
Leading zero is permitted but not 
required. 

  

%I Hour (12-hour clock) [1-12]. 
Leading zero is permitted but not 
required. 

  

%j Day number of the year [1-366]. 
Leading zeros are permitted but 
not required. 

  

%K Time duration as HHHH. Leading 
zeros are permitted but not 
required. 

1324 
0123 
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Date/Time Format String Components 

Format Description English French 

%m Month number [1-12]. Leading 
zero is permitted but not required.

  

%M Minute [0-59]. Leading zero is 
permitted but not required. 

  

%p Locale's equivalent of either a.m. 
or p.m. 

For U.S. locale: 
AM, PM, am, pm 
 

 

%Q Time duration as MMM. Leading 
zeros are permitted but not 
required. 

324 
12 
012 

 

%r Appropriate time representation 
in the 12-hour clock format with 
%p. 

  

%R Time as %H:%M.   

%S Seconds [0-61]. Leading zero is 
permitted but not required. The 
range of values is [00-61] rather 
than [00-59] to allow for the 
occasional leap second and even 
more infrequent double leap 
second. 

  

%T Time as %H:%M:%S.   

%w Weekday as a decimal number [0-
6], with 0 representing Sunday. 

  

%x Locale-appropriate date 
representation. 

06/08/02 08.06.2002 

%X Locale-appropriate time 
representation. 

17:50:03 17:50:03 

%y The year within a century [00-
99]. When a century is not 
otherwise specified, values in the 
range 69-99 refer to years in the 
twentieth century (1969 to 1999, 
inclusive). Values in the range 
00-68 refer to years in the twenty-
first century (2000 to 2068 
inclusive). Leading zeros are 
permitted but not required. 

02 02 

%Y Year including the century (for 
example 1993) [0001-9999]. 

2002 2002 
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Date String Formats 

Input Format Examples Format String 

DDMMYYYY 31012002 %d%m%Y 

YYYYMMDD 20021130 %Y%m%d 

YYYY 2002 %Y 

MMDD 1130 %m%d 

YYYY-MM 

2002-06 
2002/06 
2002.06 

%Y-%m 
%Y/%m 
%Y.%m 

YYYY-MM-DD 

2002-06-30 
2002/06/30 
2002.06.30 

%Y-%m-%d 
%Y/%m/%d 
%Y.%m.%d 

DD.MM.YY 30.06.02 %d.%m.%y 

DD.MM.YYYY 30.06.2002 %d.%m.%Y 

DD-Mmm-YYYY 

30-Jun-2002 
30.Jun.2002 
30 Jun 2002 

%d-%b-%Y 
%d.%b.%Y 
%d %b %Y 

DD-Mmm-YY 

30-Jun-02 
30.Jun.02 
30 Jun 02 

%d-%b-%y 
%d.%b.%y 
%d %b %y 

DD Mmm  

Space between day and 
month 30 Jun %d %b 

DD/MM/YY 30/06/02 %d/%m/%y 

DD/MM/YYYY 30/06/2002 %d/%m/%Y 

DD Mmmmm YYYY  

Includes full name of 
month, space between day 
and month, month and year 30 April 2002 %d %B %Y 
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Time String Formats 

Input Format Examples Format String 

HHMM 2344 %H%M 

HH:MM 23:44 %H:%M 

HHMM PM 

Space before meridian indicator 

1144 PM 
1144 AM 
1144 am %H%M %p 

HHMMPM 

1144PM 
1144AM 
1144am %H%M%p 

HH:MM PM 

Space before meridian indicator 

11:44 PM 
11:44 AM 
11:44 am %H:%M %p 

HH:MMPM 

11:44PM 
11:44AM 
11:44am %H:%M%p 

HHMMSS 234405 %H%M%S 

HH:MM:SS 
03:44:05 
22:10:36 %H:%M:%S 

HHMMSS PM 

Space before meridian indicator 

114405 PM 
114405 pm 
114405 am %H%M%S %p 

HHMMSSPM 

114405PM 
114405pm 
114405am %H%M%S%p 

HH:MM:SS PM 

Space before meridian indicator 

03:44:05 PM 
03:44:05 pm 
03:44:05 am %H:%M:%S %p 

HH:MM:SSPM 

03:44:05PM 
03:44:05pm 
03:44:05am %H:%M:%S%p 
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Time Duration String Formats 

Input Format Examples Format String 

HH:MM.D 
Duration of call in hours, minutes, and 
decimal minutes (0.1 = 6 seconds) 13:06.1 %H:%M.%G 

MMM:SS 135:05 %Q:%S 

HHHH:MM:SS  1233:05:17 %K:%M:%S 
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Appendix B: How Composer Assembles 

a Document 

How Composer Assembles a Document 
Composer assembles an HTML document using the following logic: 

1. Identify whether there is a conditional template. If yes, determine which statement 
template to use for the specific customer. If no, use the default template. 

2. Assemble the HTML for the selected template.  

Whenever an edocs tag [E] or <edocsSection=NAME> tag is encountered, the 
composing engine refers to the ALF for additional instructions.  

A set of tags, such as [E]NameGroup,G[/E], indicates to the composing engine 
that a group template needs to be inserted in statement being generated. The 
composing engine uses the logic and formatting information in the group section of 
the ALF. 

When a table tag, [E]Table,R[/E], is found, the ALF is referred to for formatting 
instructions to compose the table. 

When a field tag, [E]Field,F[/E], is found, the DDF is referred to via the ALF to 
extract and present the correct data. 

When a chart tag, [E]ChartTable,U[/E], is found, the ALF is referred to by the 
third party charting software for bitmap composition instructions.  

When the link tag, [E]NotificationLink,L[/E], is found, the system looks at 
the application configurations in the Command Center to build a custom Link to a 
login page. 

3. The group condition calls the HTML template specified to presned the group. During 
development, the Composer assembles that HTML in the places marked by [E] tags.  

4. If the file includes nested groups, then the group section of the ALF is called again. 
Another condition calls the specified HTML template. The Composer assembles that 
HTML Template body tags for the inner group(s) in the places marked by [E] tags. 
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5. Assembly of the HTML document template is complete and the bill is presented to 
the customer. 
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Index 

A 
Adding 

content to a pattern of 
table rows, 99 

ALF switch conditions 
changing, 67 
creating, 64, 67 
deleting, 67 
editing, 67 

ALF Toolbar, 42 
Alignment (left, right,center) 

adding as conditional table 
content, 95 

Alternate group coloring, 75 
Application Logic File 

before creating, 35 
contents, 37 
creating, 45 
creating for a sub-account 

view, 46 
saving, 36 
switch, 64 

Application Tree, 38 
Arithmetic element, 131 

creating, 132 
deleting, 134 
editing, 134 

B 
Background color 

adding as conditional table 
content, 95 

Bolding 

adding as conditional table 
content, 95 

C 
Cell formatting 

adding as conditional table 
content, 95 

Changing 
ALF used in a switch 

condition, 67 
chart properties, 153 
table content, 98 

Character set name 
inserting in the ALF, 41 

Chart 
attributes, 143 
axis, 147 
background, 146 
bar properties, 152 
changing properties, 153 
creating, 141 
deleting, 153 
favorite colors, 150 
general properties, 145 
information about in the 

ALF, 144 
legend, 149 
line properties, 152 
pie properties, 151 
plot area, 146 
properties, 144 
type, 145 

Charting, 141 
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Checking elements and 
dynamic fields with 
Simulator, 135 

Color 
background, adding as 

conditional table content, 
95 

text, adding as conditional 
table content, 95 

Color alternate groups, 75 
Columns 

formatting, 90, 91 
Combine element, 129 

creating, 129 
deleting, 130 
viewing, 130 

Composer, 35 
how it assembles a 

document, 163 
interface, 38 
menus, 41 
toolbars, 42 

Composing with Simulator, 
135 

Conditional statement 
multiple, 56 
syntax, 55 

Conditional templates 
adding, 67 
deleting, 71 

Conditions 
creating, 55 
creating on a table (line 

item), 91 
deleting, 80 
modifying, 79 
on a section, creating, 71 
on a templates, 67 
on group fields, 57 
viewing a list of saved, 78 
viewing properties of, 79 

Content 

adding to a pattern of table 
rows, 99 

creating, 80 
deleting, 84 
editing, 83 
table, 95 
viewing, 82 

Creating 
ALF switch condition, 64 
Application Logic File, 45, 

46 
arithmetic element, 132 
combine element, 129 
conditions, 55 
conditions on a table (line 

item), 91 
content, 80 
content (table), 80 
general filter element, 117 
link to a sort element, 105 
logic elements, 56 
page element, 112 
page set, 114 
reusable table content, 97 
sort element, 104 
top/bottom filter element, 

123 

D 
Data 

definitions, 155 
filtering, 116 
paging, 111 
sorting, 102 

Data Definition File, 35 
Data Type Report, 135 
Data-driven conditions on a 

section, 71 
Data-driven conditions on a 

table (line item), 91 
DDF, 35 
Default template, 48 

changing, 70 



Index 

e-Billing Manager Presentation Design Guide  |  165 

notification mapping, 51 
Definition Tree, 38 
Deleting 

ALF switch conditions, 67 
arithmetic element, 134 
chart, 153 
combine element, 130 
conditional template, 71 
conditions, 80 
content, 84 
filter element, 128 
group, 90 
logic elements, 64 
page element, 115 
sort element, 110 
table conditions, 99 
unused reusable table 

content, 98 

E 
e-Billing Manager 

application files, 33 
EBNF Description, 155 
Editing 

ALF switch conditions, 67 
arithmetic element, 134 
changing default template 

file, 70 
changing template for 

conditional alternate, 70 
conditions, 79 
content, 83 
filter element, 128 
group template, 89 
logic elements, 63 
page element, 115 
sort element, 109 
table conditions, 99 
template conditions, 70 

Element 
arithmetic, 131 
combine, 129 

creating link to sort, 105 
filter, 116 
paging, 111 
sort, 104 

Encoded character set. See 
character set name 

Encoded character set name, 
41 

F 
Fields 

mapping to the template, 
51 

Files, saving, 36 
Filter element, 116 

creating general, 117 
creating top/bottom, 123 
deleting, 128 
editing, 128 
general content-based, 

116 
linking to a statement, 124 
syntax, 116 
top/bottom, 116 

Filtering 
across table or group 

occurrences, 129 
data, 116 
groups, 117 
tables, 116 

Font formatting 
adding as conditional table 

content, 95 
Formatting 

adding to a pattern of table 
rows, 99 

columns, 90, 91 
tables, 90 
Toolbar, 43 

Formatting links internally, 
113 

G 
General filter element 
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creating, 117 
Group 

define condition, 88 
delete, 90 
template, editing, 89 

Group fields, 57 
Groups 

combining, 129 
deleting, 90 
filtering, 117 
mapping, 88 
mapping to the template, 

87 
sorting, 102, 103 

H 
Help, 29 

technical support, 30 
Highlighting a pattern of table 

rows, 99 
HTML 

tables, 54 
tables, inserting, 53 
text, 54 

HTML code 
inserting, 53 

HTML files, adding as 
content, 80 

HTML Mode, 40 
HTML templates, 35 

saving, 36 
Hyperlinks, 53 

adding as conditional table 
content, 95 

inserting, 53 
on an image, adding as 

conditional table content, 
95 

on text, adding as 
conditional table content, 
95 

I 
Images, 53 

adding as conditional table 
content, 95 

adding as content, 80 
inserting, 53 

Inserting 
HTML code, 53 
HTML tables, 53 
hyperlinks, 53 
images, 53 
navigational paging links, 

114 
null, 95 

Italics 
adding as conditional table 

content, 95 

J 
J2EE, 28 

L 
Line item 

creating conditions on in a 
table, 91 

Links 
linking a filter element to a 

statement, 124 
mapping notification, 84 
navigational paging, 

inserting, 114 
Logic elements 

creating, 56 
deleting, 64 
editing, 63 
syntax, 56 
viewing, 62 

M 
Mapping 

fields to the template, 51 
groups, 88 
notification link, 84 
tables and groups to the 

template, 87 
tables as charts, 141 
tables as text, 87 
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Menus 
Composer, 41 

N 
Navigational paging 

links, inserting, 114 
Non-data driven conditions 

on a table (pattern of 
rows), 99 

Notification link 
mapping, 84 

Null 
inserting, 95 

O 
Object Toolbar, 43 
Occurrences of table or 

group, combining, 129 

P 
Page 

delete, 116 
Page element 

creating, 112 
editing, 115 
removing, 115 

Page set 
creating, 114 

Paging, 111 
across table or group 

occurrences, 129 
links, inserting, 114 

Pattern of table rows, 
creating conditions on, 99 

R 
Removing a page element, 

115 
Replacing a section with text 

or an image, 95 
Reusable table content 

creating, 97 
deleting, 98 
viewing list of, 98 

S 
Saving the ALF, HTML 

template files, 36 
Section 

replacing with text or an 
image, 95 

Simulator, 135 
Toolbar, 43 

Sort element, 102 
creating, 104 
deleting, 110 
editing, 109 

Sorting 
across table or group 

occurrences, 129 
creating a link to a sort 

element, 105 
creating a sort element, 

104 
groups, 103 
tables, 102 
tables and groups, 102 

Specifying a default 
template, 48 

Statement 
paging, 111 

Sub-account 
conditions on, 57 
creating an ALF, 46 

Subtotalling, 131 
Summing rows, 131 
Suppressing display, 95 
Syntax 

filter elements, 116 
logic elements, 56 

T 
Tab 

Application, 38 
Definition, 38 

Table 
content, changing, 98 
content, creating, 80, 95 
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sort, 104 
Table conditions 

deleting, 99 
editing, 99 
viewing properties of, 98 

Tables 
combining, 129 
creating conditions on (line 

item), 91 
filtering, 116 
formatting, 90 
mapping as text, 87 
mapping to the template, 

87 
sorting, 102 

Template, 35 
changing default, 70 
conditions, 67 
conditions, editing, 70 
conditions, viewing, 70 
deleting conditional, 71 
for conditional alternate, 

changing, 70 
group, modifying, 89 
mapping a group, 88 
mapping a table as text, 87 
mapping tables and 

groups, 87 
matching fields to, 51 
Toolbar, 42 

Testing composition with 
Simulator, 135 

Text 
adding as conditional table 

content, 95 
adding as content, 80 
color, adding as conditional 

table content, 95 
replacing a section with, 95 

Toolbars 
Composer, 42 

Top/bottom filter element, 
116 
creating, 123 

V 
Validating with Simulator, 

135 
Viewing 

ALF switch conditions, 67 
combine element, 130 
conditions, list of saved, 78 
conditions, properties of, 

79 
content, 82 
list of reusable table 

content, 98 
logic elements, 62 
properties of table 

conditions, 98 
template conditions, 70 

W 
WYSIWYG Mode, 40 
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